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HELLOMOTO

Sehen und sofort aufnehmen! Ihr MOTOZINE ZN5 Telefon ist zum Aufnehmen von Fotos und Videos konzipiert!

• Schießen Sie hervorragende Fotos mit der digitalen 5-Megapixel Xenon-Blitzlichtkamera, und schicken Sie 
die Fotos an Ihre Freunde (Informationen finden Sie in Ihrer Kurzanleitung).

• Laden Sie Ihre Fotos in den KODAK Gallery Link (Informationen finden Sie in Ihrer Kurzanleitung).

• Erfassen Sie den richtigen Moment auf Video, und laden Sie den Clip in Ihren Blog (Informationen finden 
Sie in Ihrer Kurzanleitung).

• Drücken Sie die Modustasten für Kamera- und Videobetrieb, um sofort auf Video- bzw. Kamerafunktionen 
zuzugreifen (Informationen finden Sie in Ihrer Kurzanleitung).

• Übertragen Sie Ihre Lieblingsmusik mit dem Microsoft™ Windows™ Media Player 11 schnell und einfach 
auf Ihr Mobiltelefon (Seite 37).

• Hören Sie Ihre Lieblings-UKW-Radio-Sendungen mit dem 3,5 mm-Stereo-Headset (Seite 48).

• Rufen Sie beliebige Websites wie mit dem Computer auf. Verwenden Sie dazu den vollständigen 
HTML-Browser (Seite 51).

Weitere Informationen: Zum Anzeigen von Funktionsanleitungen auf Ihrem Telefon drücken Sie Menü > u Setup 
> Hilfe. Zum Anzeigen von Lernprogrammen im Internet und weiterer Informationen zu Ihrem Telefon und seinen 
Zubehörkomponenten finden Sie unter www.hellomoto.com.
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Vielen Dank, dass Sie sich für das MOTOZINE ZN5 GSM Mobiltelefon entschieden haben. Die folgenden 

Abbildungen zeigen wichtige Komponenten und Bedienelemente des Mobiltelefons.
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Hinweis: Dies ist das Standardlayout des Standby-Displays und des Hauptmenüs. Das Standby-Display und das 

Hauptmenü Ihres Telefons können unter Umständen von dieser Abbildung abweichen. In der Kurzanleitung 
finden Sie Informationen zum Ändern der Belegung der Schnellzugriffstasten und der Hauptmenüansicht.
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 www.hellomoto.com
Bestimmte Funktionen des Mobiltelefons sind von den Möglichkeiten 
und Einstellungen des Diensteanbieters abhängig. Darüber hinaus 
wurden manche Funktionen vom Diensteanbieter möglicherweise 
nicht aktiviert und/oder sind bedingt durch die Netzwerkeinstellungen 
nur eingeschränkt nutzbar. Bitte wenden Sie sich mit Fragen zu 
Verfügbarkeit und Leistungsumfang von Funktionen an Ihren 
Diensteanbieter. Alle in dieser Bedienungsanleitung enthaltenen 
Informationen zu Funktionen, Leistungsumfang und anderen 
Produkteigenschaften basieren auf den aktuellsten Informationen und 
sind zum Zeitpunkt der Drucklegung nach bestem Wissen korrekt. 
Motorola behält sich das Recht vor, Informationen oder technische 
Daten ohne vorherige Ankündigung und ohne dadurch irgendwelche 
Verpflichtungen einzugehen zu ändern.
MOTOROLA und das stilisierte M-Logo sind beim US Patent & 
Trademark Office eingetragen. Die Bluetooth-Marken gehören dem 
Eigentümer und werden von Motorola, Inc. unter Lizenz verwendet. 
Java und alle anderen Java-basierten Marken sind Marken oder 
eingetragene Marken von Sun Microsystems, Inc. in den USA und 
anderen Ländern. Microsoft und Windows sind eingetragene Marken 
der Microsoft Corporation und Windows XP und Windows Media sind 
Marken der Microsoft Corporation. Macintosh ist eine eingetragene 
Marke der Apple Computer, Inc. Alle sonstigen Produkt- oder 
Dienstleistungsnamen sind Eigentum ihrer jeweiligen Inhaber.

 ist eine Zertifizierungsmarke von Wireless Fidelity Alliance, 
Inc. KODAK, EASYSHARE und PERFECT TOUCH sind Marken von 
Kodak.
© 2008 Motorola, Inc. Alle Rechte vorbehalten.

Software-Copyright-Hinweis
Die in diesem Handbuch beschriebenen Motorola Produkte enthalten 
möglicherweise Software von Motorola oder von anderen Herstellern, 
die in Halbleiterspeichern oder sonstigen Medien gespeichert und 
urheberrechtlich geschützt sind. Gesetze in den USA und anderen 
Ländern gewähren Motorola, Inc. und den anderen 
Software-Herstellern Exklusivrechte an der urheberrechtlich 
geschützten Software, einschließlich der Exklusivrechte an Vertrieb 
und Reproduktion der urheberrechtlich geschützten Software. Deshalb 
darf die in Motorola-Produkten enthaltene und dem Urheberrecht 
unterfallende Software in keiner Weise modifiziert, Methoden des 
Reverse-Engineering unterzogen, weitergegeben oder reproduziert 
werden. Diese Beschränkung gilt im vollen, gesetzlich zulässigen 
Umfang. Darüber hinaus werden durch den Kauf von 
Motorola-Produkten weder direkt, stillschweigend, kraft 
Rechtsverwirkung noch anderweitig Lizenzrechte im Rahmen der 
Urheberrechte, Patente oder Patentanmeldungen von Motorola oder 
eines anderen Software-Herstellers, ausgenommen der normalen, 
einfachen und gebührenfreien Lizenz zur Nutzung des Produkts, die 
kraft Gesetzes beim Kauf eines Produkts gewährt wird, gewährt.
Handbuch Nr.: 68004018013
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Menüübersicht
Hauptmenü
Ò Kodak Gallery Link

m Tools
• Wecker
• Kalender
• Weltuhr
• Sync
• Download-Manager
• Datei-Manager

• Musik und Töne
• Bilder
• Videos
• Sprachaufnahmen
• Applikationen
• Unerkannte Dateien
• Meine Dokumente
• Speicherkarte *
• Mein Blog *

• SIM-Anwendungen *
• Rechner
• Wähldienste
• Aufgabenliste
• Notizen

q Anrufliste

1 Web-Zugriff
• Browser
• Bookmarks
• Meine Webseiten
• Verlauf
• Gehe zu URL
• Browser-Setup

g Nachrichten
• Nachricht erstellen
• Eingang
• Meine Ordner
• Vorlagen
• Entwürfe
• Ausgang
• Postkarte erstellen *
• E-Mail
• Mailbox anrufen

j Multimedia
• Media Finder
• Kamera
• Videokamera
• UKW-Radio
• Voice Recorder

T Spiele

L Kontakte

u Setup
• (siehe nächste Seite)

Dies ist das Standardlayout des 
Hauptmenüs. Das Menü Ihres 
Mobiltelefons kann abweichen.
Informationen zum Ändern der 
Belegung der Schnellzugriffstasten 
und der Hauptmenüansicht finden Sie 
in der Kurzanleitung. 
Tipp: Drücken Sie 7, um das aktuelle 
Menü zu beenden, oder O, um alle 
Menüs zu beenden.

* Optionale Funktionen
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Menü „Setup”
• Hilfe

• Profile

• Themes

• Standby-Display
• Navigationstasten
• Wallpaper ändern

• WiFi
• Aktuelle Verbindung
• Verfügbare Netze
• Gespeicherte Netze
• Schnellverbindung
• WiFi einrichten

• Verbindungen
• Bluetooth®

• USB-Einstellung
• Kodak EasyShare
• Mediadatei-Synchr.
• Speicherkarte
• Modem
• USB-Druck

• Sprachnetzwerke
• Aktuelles Netz
• Netze scannen
• Neues Netz such.
• Meine Netzliste
• Netzsuche
• Dienstton

• (Fortsetzung in nächster Spalte)

• Verbindungen (Fortsetzung)
• Datenverbind.

• Neue Verbindung
• Verb. bearbeiten
• Verb. löschen

• TV Out

• Anrufe
• Kurzwahl
• Anrufumleitung
• Gesprächsopt.

• Gesprächstimer
• Rufannahme
• Nachrichtenalarm
• Roaming-Signal
• Anklopfen
• Autom. Wahlwied.
• Rufabbruchton

• Wahl-Setup
• Meine Anrufer-ID
• DTMF
• Vorwahl

• Anrufsperre *
• Feste Nummern *
• Eig. Rufnummer
• Aktive Leitung *

• Telefon
• Display

• Timeout Display
• Screensaver
• Helligkeit

• Flugzeugmodus
• Akkuladezustand
• Uhrzeit & Datum
• (Fortsetzung in nächster Spalte)

• Telefon (Fortsetzung)
• Sprache
• Sprachmodus
• Texteingabe
• Zurücksetzen

• Alle Einstellungen
• Alle Daten lösch.
• Speicherk. lösch.

• Speicher anzeigen
• Eigenschaften
• Rechtliche Hinweise
• Java™-System
• OTA-Updates
• Headset-Einst.

• Auto-Antwort
• Sprachwahl

• Sicherheit
• Telefonsperre
• Anwend.sperre
• SIM-PIN
• Passwörter änd.
• Zertifikate

• Netz
• Aktuelles Netz
• Netze scannen
• Neues Netz such.
• Meine Netzliste
• Netzsuche
• Dienstton

* Optionale Funktionen
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Benutzung und Pflege
Use and Care

Schützen Sie Ihr Mobiltelefon von Motorola vor: 

Flüssigkeiten jeder Art Staub und Schmutz
Setzen Sie das Telefon weder Wasser, 
Regen, extremer Luftfeuchtigkeit, 
Schweiß noch anderer Feuchtigkeit aus. 
Falls das Mobiltelefon nass wird, 
versuchen Sie nicht, das Trocknen 
mithilfe eines Ofens oder Haarföns zu 
beschleunigen, da hierdurch Schäden 
am Mobiltelefon entstehen können.

Setzen Sie das Telefon weder Staub, 
Schmutz, Sand, Nahrungsmittelresten 
noch anderen Reststoffen aus.

Extreme Hitze oder Kälte Reinigungsmittel
Meiden Sie Temperaturen unter 0 °C und 
über 45 °C.

Reinigen Sie das Telefon mit einem 
trockenen weichen Tuch. Verwenden Sie 
weder Alkohol noch andere 
Reinigungsmittel.

Mikrowellenofen Stöße 
Trocknen Sie das Telefon nicht in einem 
Mikrowellenofen.

Lassen Sie das Telefon nicht fallen. 
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EU-Richtlinien Konformitätserklärung

EU Conformance

Hiermit erklärt Motorola, dass dieses Produkt den folgenden 
Richtlinien entspricht:

• Den wesentlichen Anforderungen und allen anderen relevanten 
Bestimmungen der Richtlinie 1999/5/EG

• Allen anderen relevanten EU-Richtlinien

Die obige Abbildung zeigt ein Beispiel für eine typische 
Produktgenehmigungsnummer.

Sie können die der Richtlinie 1999/5/EG (die R&TTE-Richtlinie) 
zugehörige Konformitätserklärung (DoC) zu Ihrem Produkt unter der 
Internetadresse www.motorola.com/rtte abrufen. Geben 
Sie dazu die auf dem Typenschild Ihres Produkts angegebene 
Genehmigungsnummer in das auf der Website befindliche Feld 
„Suchen“ ein.

[nur Frankreich]

0168 Product
Approval
Number
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Wichtige Informationen

Informationen zu 
diesem Handbuch
Dieses Handbuch verwendet für das Öffnen einer 
bestimmten Menüfunktion die folgende Schreibweise:

Zu finden unter: s > g Nachrichten > Nachricht 

erstellen

Gehen Sie dazu im Hauptdisplay wie folgt vor:

  

1 Drücken Sie zum Öffnen des Hauptmenüs die 
mittlere Taste s.

2 Drücken Sie die Navigationstaste S, um zu 
g Nachrichten zu blättern, und drücken Sie dann 
s, um diese Option zu wählen.

3 Drücken Sie die Navigationstaste S, um zu 
Nachricht erstellen zu blättern, und drücken Sie dann 
s, um diese Option zu wählen.

ACHTUNG: Lesen Sie vor der 
Verwendung des Telefons die 
Sicherheitshinweise sowie die rechtlichen 
Informationen in der Kurzanleitung 
gründlich durch.
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In diesem Handbuch werden folgende Symbole 

verwendet:

Akku

Akku einsetzen und laden
Ausführliche Informationen zum Einsetzen und Laden 
des Akkus finden Sie in der Kurzanleitung. 

Tipp: Die Schaltkreistechnik der Motorola-Akkus 

schützen den Akku vor Schäden durch Überladung.

Hinweis: Verbinden Sie zum Aufladen des 
Akkus den Micro USB-Anschluss des 
Telefons über das zugehörige Kabel mit 
dem USB-Anschluss eines Computers. 
Sowohl Telefon als auch Computer müssen 
eingeschaltet sein, und im Computer müssen die 
richtigen Softwaretreiber installiert sein. 
Ein Motorola Original-USB-Kabel und die zugehörige 
Software sind ggf. im Lieferumfang des Telefons 
enthalten. Dieses Zubehör ist auch separat erhältlich.

Vorsicht: Wenn Sie Ihr Mobiltelefon mit einem 
Computer mit USB-Hub verbinden, an dem bereits 
mehrere USB-Geräte angeschlossen sind, kann es zur 
Überladung des Telefonakkus kommen. Um eine 
Überladung zu vermeiden, sollten Sie Ihr Mobiltelefon 
über einen dafür vorgesehenen USB-Anschluss mit 
dem Computer verbinden.

Symbole

Dies bedeutet, dass eine Funktion vom 
Netz, von der SIM-Karte oder vom 
Teilnehmervertrag abhängig und 
möglicherweise nicht überall verfügbar ist. 
Weitere Informationen erhalten Sie von 
Ihrem Diensteanbieter.

Mit diesem Zeichen werden Funktionen 
gekennzeichnet, die optionales Zubehör 
erfordern.
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Grundlagen

Display
Das Standby-Display wird beim Einschalten des 
Telefons angezeigt.

Hinweis: Je nach den von Ihrem Netzbetreiber 
getroffenen Voreinstellungen kann der Home Screen 
Ihres Mobiltelefons von dieser Abbildung abweichen.

Zum Wählen einer Rufnummer müssen Sie im 
Standby-Display nur die Ziffern eingeben und N 
drücken.

Drücken Sie die mittlere Taste s oder den Softkey 
Menü, um das Hauptmenü zu öffnen.

Drücken Sie Optionen auf dem Standby-Display, um den 
Signaltyp zu ändern, das Wallpaper zu ändern, eine 
Nachricht zu lesen oder zu erstellen, ein Video 
aufzuzeichnen, einen Alarm festzulegen oder ein 
Bluetooth®-Gerät zu suchen.

Drücken Sie die Navigationstaste S nach oben, 
unten, links oder rechts auf dem Standby-Display, 
um auf die wichtigsten Menüfunktionen zuzugreifen. 

E
^ C

Datum

Uhrzeit

Softkey-
Label links

Softkey-
Label rechts

Diensteanbieter

31/03/2008

10:10

Optionen Menü

Funktions-
symbole
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Informationen zum Anzeigen, Ausblenden oder 

Ändern der Funktionssymbole im Standby-Display 
finden Sie in der Kurzanleitung.

Tipp: Sie benötigen Hilfe? Drücken Sie Menü > u Setup 
> Hilfe. Wählen Sie ein Hilfe-Thema aus, um 
Informationen zu den Funktionen des Mobiltelefons zu 
erhalten.

Am oberen Rand des Home Screens können die 
folgenden Statussymbole angezeigt werden:

 1 Signalstärke – Zeigt die Stärke des Netzsignals 
an.

2 EDGE/GPRS – Zeigt an, dass das Mobiltelefon 
die Hochgeschwindigkeitsdatenverbindung 
Enhanced Data for GSM Evolution (EDGE) Z oder die 

Netzwerkverbindung General Packet Radio Service 

(GPRS) g verwendet.

3 Bluetooth- oder WiFi-Anzeige – Zeigt den 
Bluetooth- bzw. WiFi-Status an:

4 Nachrichtensymbol – Wird angezeigt, wenn 
Sie eine neue Text- oder Sprachnachricht 
erhalten. Beispiele für weitere Anzeigen:

5 Profilanzeige – Zeigt das eingestellte Signalprofil 
an:

2 41 3 765

& leuchtet blau = Bluetooth aktiviert

& leuchtet grün = Bluetooth verbunden

& blinkt blau = Bluetooth-Erkennungsmodus

è leuchtet rot = WiFi eingeschaltet

V = E-Mail-Nachricht T = Sprachnachricht

N = Klingelton K = Klingelton und Vibrieren
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6 Aktive Leitung – Das Symbol B weist auf 
eine aktive Verbindung hin, während E 
darauf hinweist, dass die Rufumleitung 
eingeschaltet ist. Bei SIM-Karten mit zwei 
Rufnummern sind folgende Anzeigen möglich:

7 Akkuladezustand –  Vertikale Balken zeigen den 
Akkuladezustand an. Bei Anzeige der Meldung 
Akku fast leer muss das Mobiltelefon aufgeladen 
werden.

H = Vibrieren I = Vibr., dann Klingelton

J = Stumm

G = Leitung 1 aktiv F = Leitung 2 aktiv

D = Rufumleitung 
für Leitung 1 
eingeschaltet

C = Rufumleitung 
für Leitung 2 
eingeschaltet
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Texteingabe
Bei der Nutzung bestimmter Funktionen ist eine 
Texteingabe erforderlich.

So ändern Sie die Einstellungen für Texteingabe und 
Sprache:

Zu finden unter: s > u Setup > Telefon > Texteingabe

Großschreibung ändern: Drücken Sie 0, um zu 
Großbuchstaben (Ä), zu Wortanfang groß (Í) oder 
zu Kleinbuchstaben (kein Symbol) zu wechseln.

Wortlernfunktion aktivieren: Das Telefon kann 
eingegebene neue Wörter lernen, um die vereinfachte 
Texteingabe und Wortergänzung zu verbessern. 
Drücken Sie Optionen > Texteingabe > Vereinfachte Texteingabe 
> Wörter lernen. Wenn die Funktion aktiviert ist, wird das 
Symbol Ç angezeigt.

Zeichenzähler
Drücken Sie #, um einen 
Texteingabemodus auszu- 

wählen.

Ein blinkender Cursor 
zeigt einen 

Einfügepunkt an.

Drücken Sie Optionen, 
um die Optionen für 
die Texteingabe zu 

ändern.

Neue Nachricht
SMS:0ÊË

Optionen Senden an

Texteingabemodi

Ê „Wort“-Modus (siehe Seite 18)

É „abc“-Modus (siehe Seite 19)

È Numerischer Modus (siehe Seite 20)

Ã Symbolmodus (siehe Seite 20)
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Wortergänzung aktivieren: Einstellen der 
Wortergänzung auf Ihrem Telefon entsprechend den 
von Ihnen eingegebenen Buchstaben. Drücken Sie 
Optionen > Texteingabe > Vereinfachte Texteingabe > Wortergänzung. 
Wenn die Funktion aktiviert ist, wird das Symbol Æ 
angezeigt.

Interpunktionszeichen eingeben: Drücken Sie 1 
für die Eingabe von Satzzeichen oder anderen Zeichen.

Text bearbeiten oder löschen: Drücken Sie S, um 
den Cursor rechts neben den Text zu verschieben, den 
Sie bearbeiten möchten. Drücken Sie die 
Rück-/Löschtaste 7, um das Zeichen links vom 
Cursor zu löschen. Halten Sie 7 gedrückt, um das 
gesamte Wort zu löschen.

Wort-Modus
Drücken Sie # in einem Texteingabebildschirm, um 
zum Wort-Modus der vereinfachten Texteingabe zu 
wechseln. Das Symbol Ê wird im Display angezeigt.

Der Wort-Modus ermöglicht die vereinfachte Eingabe 
von Wörtern mit nur einem Tastendruck pro 

Buchstabe. Das Telefon schlägt mögliche Wörter für 
die bisher gedrückte Tastenkombination vor.

Wenn Sie beispielsweise die Tasten 7764 
drücken, zeigt das Display Folgendes an:

Sie können die 
Textergänzung aktivieren 

(Æ) oder deaktivieren (Ç).

Drücken Sie 7 , um 
das Zeichen links 

vom Cursor zu 
löschen.

Drücken Sie *, um Prog 
und ein Leerzeichen 

einzugeben.

Drücken Sie S oben/unten, 
um weitere Wörter anzuzeigen. 
Drucken Sie s, um ein Wort 

auszuwählen.

Prog ramm

Neue Nachricht

Optionen Senden an

SMS:4ÊÆ
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abc-Modus
Drücken Sie # in einem Texteingabebildschirm, um 
zum „abc“-Texteingabemodus zu wechseln. 
Das Symbol É wird im Display angezeigt.

Die Texteingabe erfolgt durch wiederholtes Drücken 
einer Taste, um durch die der Taste entsprechenden 
Buchstaben, Ziffern und Symbole zu blättern. 
Wiederholen Sie diesen Schritt für jeden Buchstaben, 
den Sie eingeben möchten.

Wenn Sie beispielsweise die Taste 7 ein Mal 

drücken, wird im Display möglicherweise Folgendes 
angezeigt:

P rog

Neue Nachricht

Optionen Senden an

SMS:1ÉÆ

Das Zeichen wird am 
Einfügepunkt 

angezeigt.

Nach zwei Sekunden wird das Zeichen übernommen, 
und der Cursor springt zum nächsten Einfügepunkt.



20 Grundlagen

Wenn die Wortergänzung aktiviert ist, versucht das 

Telefon, das restliche Wort zu vervollständigen:

• Drücken Sie s, um das vorgeschlagene 
Wort auszuwählen.

• Drücken Sie S rechts, um das 
vorgeschlagene Wort und ein Leerzeichen 
einzugeben.

• Wenn Sie ein anderes Wort wünschen, tippen 
Sie die restlichen Buchstaben über die 
Tastatur ein.

Numerischer Modus
Drücken Sie solange # in einem 
Texteingabebildschirm, bis È angezeigt wird. Geben 
Sie dann die gewünschten Ziffern ein.

Tipp: Sie möchten nur eine Zahl eingeben? Zum 
schnellen Eingeben einer Zahl halten Sie eine 
Zifferntaste solange gedrückt, bis die Zahl angezeigt 
wird.

Symbol-Modus
Drücken Sie solange # in einem 
Texteingabebildschirm, bis Ã angezeigt wird. Im 
Display wird das Symbol der jeweiligen Taste 
angezeigt. Drücken Sie wiederholt S oben/unten, 
um verschiedene Symbole anzuzeigen. Um ein 
Symbol einzufügen, drücken Sie die entsprechende 
Taste, oder blättern Sie zu dem Symbol, und drücken 
Sie s.

Lautstärke
Drücken Sie die 
Lautstärketasten, um:

• das Anrufsignal 
abzuschalten

• die Lautstärke der Hörmuschel oder des 
Lautsprechers während eines Anrufs zu 
ändern
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• die Lautstärke während der Wiedergabe eines 

Lieds oder eines Videos zu ändern

• das Signalprofil im Standby-Display 
festzulegen (drücken Sie die Lautstärketasten, 
um zu einem Profil zu blättern, und drücken 
Sie anschließend s)

Sperren/Entsperren-Taste
Mit der Sperren/Entsperren-Taste 
können Sie die Tastatur sperren 
und entsperren. Drücken Sie sie 
zum Sperren nach unten und 
zum Entsperren nach oben.

Sprachbefehle
Mit Sprachbefehlen können Sie dem Telefon 
Anweisungen erteilen.

Hinweis: Sprachbefehle werden nicht für alle 

Sprachen unterstützt.

Sprachwahl
Sie können einen Eintrag in Ihrer Kontaktliste anrufen, 
indem Sie den Namen des Eintrags oder die einzelnen 
Ziffern einer Rufnummer sprechen.

  

1 Halten Sie N gedrückt. Das Telefon lädt die 
Spracherkennungssoftware und fordert Sie dann 
auf, einen Befehl oder Namen zu sprechen.

2 Warten Sie auf den Signalton, bevor Sie den 
Namen eines Eintrags aus der Kontaktliste 
sprechen. Der Name wird bestätigt und die 
Verbindung anschließend hergestellt.

oder

Sagen Sie „Nummer wählen“. Sie werden 
aufgefordert, die Ziffern der Rufnummer zu 
sprechen. Sprechen Sie die Ziffern. Der Name 
wird bestätigt und die Verbindung anschließend 
hergestellt.
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Tipps:

• Sie können den Namen des Kontakts und den 
Nummerntyp zusammen sprechen. Sagen Sie 
z. B. „Johannes Schmidt Mobil“, um die für 
Johannes Schmidt gespeicherte 
Mobiltelefonnummer anzurufen.

• Um die Hilfe zu Sprachbefehlen aufzurufen, 
halten Sie N gedrückt. Drücken Sie 
anschließend Hilfe.

Telefonfunktionen per 
Sprachbefehl aktivieren
Mit Sprachbefehlen können Sie Anwendungen öffnen 
und viele grundlegende Telefonfunktionen ausführen.

  

1 Halten Sie N gedrückt. Sie werden 
aufgefordert, einen Befehl zu sprechen.

2 Halten Sie N gedrückt, um die Liste der 
Sprachbefehle anzuzeigen.

Sprachmodus
Sie können Ihr Telefon so einstellen, dass 
Anrufer-ID-Informationen zu eingehenden Nachrichten 
angesagt, Menüfunktionen oder Einträge in der 
Kontaktliste sowie eingehende Nachrichten vorgelesen 
und Informationen zu Telefonfunktionen akustisch 
wiedergegeben werden.

Zu finden unter: s > u Setup > Telefon 
> Sprachmodus

Schnellzugriff: Halten Sie N gedrückt. Wenn Sie 
aufgefordert werden, einen Befehl zu sprechen, sagen 
Sie „Sprachmodus“.

Freisprechfunktion
Drücken Sie während eines Anrufs Optionen > Lautsprecher 
ein, um die Freisprechfunktion ein- oder auszuschalten. 
Auf dem Display wird das Lautsprechersymbol 
angezeigt, bis Sie die Funktion deaktivieren (drücken Sie 
dazu Optionen > Lautsprecher aus) oder den Anruf beenden.
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Hinweis: Die Benutzung von Mobiltelefonen kann 

beim Führen eines Kfz Ablenkungen verursachen. 
Beenden Sie das Gespräch, wenn Sie sich nicht auf 
das Fahren konzentrieren können. Außerdem ist die 
Verwendung von drahtlosen Geräten und deren 
Zubehör in bestimmten Umgebungen unter 
Umständen verboten. Die Gesetze und Vorschriften 
zur Nutzung dieser Produkte müssen stets 
eingehalten werden.

Codes und Passwörter
Der vierstellige Entsperrcode Ihres Telefons ist 
werksseitig auf 1234 eingestellt. Der sechsstellige 
Sicherheitscode Ihres Telefons ist werksseitig auf 
000000 eingestellt. Sofern der Diensteanbieter diese 
Codes nicht geändert hat, sollten Sie dies tun:

Zu finden unter: s > u Setup > Sicherheit 
> Passwörter änd.

Sie können auch Ihre SIM-PIN oder das Passwort für 
Anrufsperren ändern.

Falls Sie Ihren Entsperrcode vergessen: Geben Sie 
an der Eingabeaufforderung Bitte Entsperrcode eingeben 
„1234“ oder die letzten vier Ziffern Ihrer Rufnummer 
ein. Sollte dies nicht funktionieren, drücken Sie #, 
und geben Sie stattdessen den sechsstelligen 
Sicherheitscode ein.

Wenn Sie andere Codes vergessen haben: Wenn 
Sie den Sicherheitscode, den PIN-Code der SIM-Karte, 
den PIN2-Code oder das Passwort für die Anrufsperre 
vergessen haben, wenden Sie sich an Ihren 
Diensteanbieter.
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Mobiltelefon 
sperren/entsperren
Sie können das Mobiltelefon sperren, damit es 
niemand außer Ihnen benutzen kann. Zum Sperren 
oder Entsperren Ihres Telefons benötigen Sie den 
vierstelligen Entsperrcode.

So wird das Telefon manuell gesperrt:

Zu finden unter: s > u Setup > Sicherheit 
> Telefonsperre > Jetzt sperren

So wird das Telefon beim Ausschalten automatisch 

gesperrt:

Zu finden unter: s > u Setup > Sicherheit 
> Telefonsperre > Einschaltsperre > Ein
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Personalisieren

Profile
Sie können das Signalprofil des Telefons schnell an Ihre 
Aktivitäten oder Umgebung anpassen. Jedem Profil 
sind unterschiedliche Signaltöne oder Vibrationsalarme 
für eingehende Anrufe und andere Ereignisse 
zugeordnet. Das Signalprofil-Symbol wird oben auf dem 
Standby-Display angezeigt (siehe Seite 15).

So ändern Sie Ihr Profil: Drücken Sie im 
Standby-Display die externen Lautstärketasten seitlich 
am Telefon. Sie können im Standby-Display auch 
Optionen > Signaltyp ändern oder Profil ändern drücken.

Das Profil Stumm stellt Ihr Mobiltelefon solange stumm, 
bis Sie ein anderes Profil einstellen.

Schnellzugriff: Halten Sie im Standby-Display # 
gedrückt, um schnell zwischen Vibrieren und Klingelton zu 
wechseln.

Signalprofil-Einstellungen ändern
Sie können die Signaltöne ändern, die für eingehende 
Anrufe und andere Ereignisse verwendet werden. Sie 
können außerdem die Signallautstärke, die 
Tastenlautstärke und die Lautstärke für die 
Wiedergabe der Multimediadateien ändern. Bei 
SIM-Karten mit zwei Rufnummern können Sie 
verschiedene Klingeltöne einstellen, um eingehende 
Anrufe auf Leitung 1 oder Leitung 2 zu unterscheiden.

N Klingelton K Klingelton & Vibr.

H Vibrieren I Vibr., dann Klingelton

J Stumm
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Hinweis: Der Klingelton für den Signaltyp Stumm  und 

einige Einstellungen für bestimmte Signaltypen 
können nicht geändert werden.

Zu finden unter: s > u Setup > Profile > Signaltyp 
> Signaltyp

  

1 Drücken Sie S links/rechts, um die 
Registerkarte Signale [, Lautstärke i, 
Nachrichten ] oder Einstellungen # 
auszuwählen.

2 Drücken Sie S oben/unten, um zu der 
Einstellung zu blättern, die Sie ändern möchten. 
Drücken Sie dann s.

3 Drücken Sie Zurück, um die Änderungen zu 
übernehmen.

So setzen Sie die Standardeinstellungen für einen 
Signaltyp zurück:

Zu finden unter: s > u Setup > Profile > Signaltyp 
> Signaltyp, drücken Sie Optionen > Zurücksetzen

Neues Profil erstellen
So erstellen Sie ein neues Profil mit den gewünschten 
Signaltönen und Lautstärkeeinstellungen:

Zu finden unter: s > u Setup > Profile > Signaltyp 
> Signaltyp

  

1 Geben Sie einen Namen ein, und ändern die 
Einstellungen wie im vorherigen Abschnitt 
beschrieben.

2 Drücken Sie Optionen > Als Profil speichern

3 Geben Sie einen Namen für das Profil ein, und 
drücken Sie Speichern, um es zu speichern.

Oder gehen Sie wie folgt vor:

Zu finden unter: s > u Setup > Profile, drücken 
Sie Optionen > Profil erstellen
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Hinweis: Einstellungen für ein Signalprofil können 

auch durch ein Theme bestimmt werden. Wenn Sie 
ein neues Theme anwenden, können Sie auswählen, 
die Signaleinstellungen des Themes auf das aktuelle 
Profil anzuwenden. Durch Auswahl dieser Option wird 
das aktuelle Profil geändert, und es verwendet die 
Signaleinstellungen des Themes.

Profile bearbeiten oder löschen
So bearbeiten Sie ein Profil:

Zu finden unter: s > u Setup > Profile, blättern 
Sie zum Profil, drücken Sie Optionen > Bearbeiten

Hinweis: Sie können das Profil Stumm und einige 
Einstellungen für bestimmte Profile nicht ändern.

So löschen Sie ein benutzerdefiniertes Profil:

Zu finden unter: s > u Setup > Profile, blättern 
Sie zum Profil, drücken Sie Optionen > Löschen

Standardeinstellungen 
wiederherstellen
So löschen Sie alle benutzerdefinierten Profile und 
stellen die ursprünglichen Profil-Einstellungen Ihres 
Telefons wieder her:

Zu finden unter: s > u Setup > Profile, drücken 
Sie Optionen > Zurücksetzen

Zeit und Datum
Das Telefon kann die Uhrzeit und das Datum 
automatisch aktualisieren. Datum und Uhrzeit 
werden für die Funktion Kalender benötigt.

So synchronisieren Sie die Uhrzeit und das Datum 
mit dem Netz:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & 

Datum > Uhrzeit Auto-Update > Ein
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So stellen Sie die Uhrzeit und das Datum manuell ein:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & 

Datum > Uhrzeit Auto-Update > Aus, anschließend 
> Zeit und Datum

Zum Einstellen der Uhrzeit und des Datums drücken 
Sie S links/rechts, um zu einer Einstellung zu 
blättern. Drücken Sie anschließend S oben/unten, 
um die Einstellung zu ändern. Drücken Sie Einstellen, um 
die Einstellungen zu speichern.

So zeigen Sie im Standby-Display die digitale Uhrzeit 
im 12-Stunden- oder 24-Stunden-Format an:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & 

Datum > Uhrzeitformat > 12-Stunden-Format oder 24-Stunden-Format

So legen Sie das Datumsformat im Standby-Display 
fest:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & 

Datum > Datumsformat

So legen Sie die Zeitzone fest:

Zu finden unter: s > u Setup > Telefon > Uhrzeit & 

Datum > Zeitzone, und wählen Sie anschließend eine Stadt 
in Ihrer Zeitzone aus

Schnellzugriff: Geben Sie über die Buchstabentasten 
die ersten Buchstaben der gesuchten Stadt ein.

Themes
Mit einem Telefon-Theme können Sie das 
Aussehen und den Sound Ihres Telefons 
personalisieren. In der Regel umfassen Themes ein 
Wallpaper, einen Screensaver und Signaltöne.

So aktivieren Sie ein Theme:

Zu finden unter: s > u Setup > Themes > Theme

Informationen zum Herunterladen von Themes finden 
Sie auf Seite 51.
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So löschen Sie ein Theme:

Zu finden unter: s > u Setup > Themes, blättern 
Sie zum Theme, und drücken Sie Optionen > Verwalten 
> Löschen

Hinweis: Sie können nur heruntergeladene Themes 
oder benutzerdefinierte Themes, die Sie erstellt 
haben, löschen.

Klingeltöne anhören
So hören Sie die Klingeltöne auf dem Telefon an und 
wählen den Klingelton aus, den das Theme 
verwendet:

Zu finden unter: s > u Setup > Themes, drücken 
Sie Optionen > Bearbeiten > Anrufsignal > Sounds u. Anrufsign. 
> Vorinst. Anrufsignale

  

1 Drücken Sie S oben/unten, um zum jeweiligen 
Klingelton zu blättern und ihn zu testen.

2 Drücken Sie s, um den markierten Klingelton 

auszuwählen.

3 Drücken Sie Speichern, um die Auswahl zu 
speichern.

Ein Foto als Wallpaper verwenden
So verwenden Sie ein Foto als Hintergrundbild 
(Wallpaper) im Standby-Display:

Zu finden unter: s > u Setup > Themes, drücken 
Sie Optionen > Bearbeiten

  

1 Drücken Sie S, um die Registerkarte Bilder $ 
auszuwählen.

2 Drücken Sie S nach unten, um zu Wallpaper zu 
blättern, und drücken Sie dann s, um diese 
Option zu wählen.
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3 Blättern Sie zu dem Foto, das Sie verwenden 

möchten, und drücken Sie dann Auswählen.

Hinweis: Zum Suchen von Fotos auf der 
Speicherkarte wählen Sie Zur. zu Bilder > Zur. zu Meine 

Dat. > Speicherkarte > Bilder aus.

4 Drücken Sie Speichern, um die Auswahl zu 
speichern.

Fotos, die von einem anderen Gerät auf das 
Mobiltelefon übertragen wurden, haben 
möglicherweise nicht die für ein Hintergrundbild 
erforderliche Größe. So passen Sie die Größe eines 

Hintergrundfotos an:

Zu finden unter: s > u Setup > Themes, drücken 
Sie Optionen > Bearbeiten

  

1 Drücken Sie S, um die Registerkarte Bilder $ 
auszuwählen.

2 Drücken Sie S nach unten, um zu Wallpaper-Layout 

zu blättern, und drücken Sie danns, um diese 
Option zu wählen.

3 Blättern Sie zu Anpassen, und drücken Sie dann 
Auswählen.

4 Drücken Sie Speichern, um die Einstellung zu 
speichern.

Theme ändern
Zu finden unter: s > u Setup > Themes, blättern 
Sie zum Theme, drücken Sie Optionen > Bearbeiten

  

1 Drücken Sie S links/rechts, um die 
Registerkarte Sounds [ oder Bilder $ 
auszuwählen.

2 Drücken Sie S oben/unten, um zu der 
Einstellung zu blättern, die Sie ändern möchten. 
Drücken Sie dann s.
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3 Blättern Sie zur gewünschten Bild- oder 

Sounddatei, und wählen Sie sie aus.

4 Drücken Sie Speichern, um die Änderungen am 
Theme zu speichern.

Das Wallpaper wird als Hintergrundbild auf dem 
Standby-Display angezeigt.

Das Screensaver wird nach einem angegebenen Zeitraum 
der Inaktivität angezeigt.

Mit Skins ändern Sie das Erscheinungsbild des 
Telefondisplays.

So führen Sie das Zurücksetzen der 
Standardeinstellungen für ein geändertes Theme aus:

Zu finden unter: s > u Setup > Themes > Theme, 
drücken Sie Optionen > Verwalten > Zurücksetzen

So stellen Sie das Standard-Theme für das Telefon 
wieder her:

Zu finden unter: s > u Setup > Themes, drücken 

Sie Optionen > Verwalten > Auf Standardeinstellungen zurücksetzen

Neues Theme erstellen
Zu finden unter: s > u Setup > Themes, drücken 
Sie Optionen > Theme erstellen oder Kopie erstellen

Displayeinstellungen
So stellen Sie die Helligkeit des internen Displays ein:

Zu finden unter: s > u Setup > Telefon > Display 
> Helligkeit

Zum Einsparen der Akkuleistung kann das Display 
ausgeschaltet werden, wenn Sie Ihr Telefon nicht 
verwenden. So legen Sie das Verzögerungsintervall 
für das Deaktivieren des Displays fest:

Zu finden unter: s > u Setup > Telefon > Display 
> Timeout Display
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So aktivieren bzw. deaktivieren Sie den internen 

Screensaver des Displays:

Zu finden unter: s > u Setup > Telefon > Display 
> Screensaver > Ein oder Aus

Tipp: Zur Verlängerung der Akkulaufzeit empfiehlt es 
sich, den Screensaver zu deaktivieren.

Rufannahme
Sie können einen eingehenden Anruf annehmen, 
indem Sie eine beliebige Taste drücken. So aktivieren 
bzw. deaktivieren Sie eine Tasten-Annahmeoption:

Zu finden unter: s > u Setup > Anrufe 
> Gesprächsopt. > Rufannahme > Tasten drücken

Hinweis: Zum Annehmen eines Anrufs drücken 
Sie N.
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Anrufe

Abschalten des 
Anrufsignals
Drücken Sie die externen Lautstärketasten seitlich am 
Telefon, um den Klingelton abzuschalten, bevor Sie 
einen Anruf entgegennehmen.

Letzte Anrufe
Das Mobiltelefon verwaltet Listen der ein- und 
ausgehenden Anrufe, auch wenn bei diesen Anrufen 
kein Gespräch zustande kam. Die Liste beginnt mit 
den neuesten Anrufen. Die jeweils ältesten Anrufe 
werden gelöscht, wenn neue Anrufe hinzukommen.

Schnellzugriff: Drücken Sie im Standby-Display N, 
um die Liste Gewählte Anrufe anzuzeigen.

Zu finden unter: s > q Anrufliste

  

1 Drücken Sie S links/rechts, um eine Anrufliste 
auszuwählen: Alle Anrufe, Gewählte Anrufe, Beantwort. Anrufe, 
Entgangene Anrufe oder Häufige Anrufe.

2 Drücken Sie S oben/unten, um zu einer 
Telefonnummer zu blättern.

Anhand der Symbole erkennen Sie, ob ein Anruf 
eingegangen ist -, abgegangen ist + oder verpasst 
wurde =. Ein Häkchen neben dem Symbol 
kennzeichnet einen verbundenen Anruf.

• Zum Anrufen der Rufnummer drücken Sie N.

• Zum Anzeigen von Detailinformationen (z. B. 
Datum und Uhrzeit) zu diesem Anruf drücken 
Sies.
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• Drücken Sie Optionen, um andere Vorgänge für die 

Nummer auszuführen (Nachricht senden, als 
Kontakt speichern) oder Optionen für die letzten 
Anrufe festzulegen.

Wahlwiederholung
  

1 Drücken Sie im Standby-Display auf N, um die 
Liste Gewählte Anrufe anzuzeigen.

2 Blättern Sie zu der Nummer, die Sie anrufen 
möchten, und drücken Sie N.

Wenn Sie ein Besetztzeichen hören und die 
Meldung Anruf gescheitert angezeigt wird, drücken 
Sie N oder Erneut vers., um die Rufnummer erneut zu 
wählen. Beim Durchstellen des Anrufs wird die 
Meldung Verbunden angezeigt.

Zurückrufen
Das Mobiltelefon erfasst unbeantwortete Anrufe und 
zeigt die Meldung X entgangene Anrufe an. Dabei bezeichnet 
X die Anzahl der verpassten Anrufe.

Wenn die Meldung X entgangene Anrufe angezeigt wird, 
drücken Sie s, um die Liste Entgangene Anrufe 
anzuzeigen. Blättern Sie zu dem Eintrag, den Sie 
zurückrufen möchten, und drücken Sie N.

Anrufer-ID
Mit der Anrufer-Identifizierung (Anrufer-ID) wird 
die Rufnummer eines eingehenden Anrufs auf 
dem Display des Telefons angezeigt.

Ihr Telefon zeigt Name und Bild des Anrufers an, wenn 
diese in der Kontaktliste gespeichert sind. Falls keine 
Anruferkennung übertragen wird, so wird im Display 
die Nachricht Eingehender Anruf ... angezeigt.
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Hinweis: Bild-IDs sind für auf der SIM-Karte 

gespeicherte Kontakte nicht verfügbar.

Tipp: Möchten Sie den Anrufer schon am Klingelton 
erkennen? Informationen zum Zuweisen eines 
speziellen Klingeltons für einen Kontakt finden Sie auf 
Seite 76.

Um Ihre Rufnummer beim nächsten abgehenden 
Anruf anzuzeigen bzw. zu unterdrücken, geben Sie die 
Rufnummer ein, die Sie wählen möchten, und drücken 
dann Optionen > ID anzeigen oder ID verbergen.

So übermitteln oder unterdrücken Sie Ihre 

Rufnummer für alle Anrufe:

Zu finden unter: s > u Setup > Anrufe > Wahl-Setup 
> Meine Anrufer-ID > Alle Anrufe > ID übermitteln oder ID verbergen

Notrufe
Ihr Diensteanbieter programmiert eine oder mehrere 
Notrufnummern (beispielsweise 999, 911 oder 112), so 
dass Sie diese jederzeit anrufen können, auch wenn das 
Telefon gesperrt oder keine SIM-Karte eingelegt ist.

Hinweis: Überprüfen Sie dies bei Ihrem 
Diensteanbieter, da die Notrufnummern 
länderabhängig sind. Das Telefon funktioniert u. U. 
nicht überall. Aufgrund von Netzproblemen, 
Umwelteinflüssen oder Interferenzen sind Notrufe 
manchmal nicht möglich. Verlassen Sie sich bei 
erforderlichen Anrufen (z. B. medizinische Notfälle) 
nicht ausschließlich auf Ihr Mobiltelefon.

So tätigen Sie einen Notruf: Schalten Sie das Telefon 
ein, wählen Sie die Notrufnummer, und drücken Sie 
anschließend die Sendetaste N, um die 
Notrufnummer anzurufen.
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Sprachnachrichten
Empfangene Sprachnachrichten werden in Ihrer 
Mailbox gespeichert. Zum Abhören der 
Nachrichten rufen Sie Ihre Mailbox an.

Hinweis: Von Ihrem Diensteanbieter erhalten Sie 
möglicherweise weitere Informationen zur Nutzung 
dieser Funktion.

Wenn Sie eine Sprachnachricht erhalten, werden im 
Telefondisplay Neue Sprachnachr. und das 
Sprachnachrichtensymbol U angezeigt.

So prüfen Sie, ob Sprachnachrichten eingegangen 
sind:

Zu finden unter: s > g Nachrichten > Mailbox anrufen

Schnellzugriff: Ihr Diensteanbieter hat 
möglicherweise Ihre Mailbox-Nummer unter der 
Schnellwahltaste 1 abgelegt. Ist dies der Fall, halten 
Sie im Standby-Display 1 gedrückt, und hören Sie 
die Mailbox-Nachricht(en) ab.
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Unterhaltung

Kamera
Schießen Sie hervorragende Fotos mit der digitalen 
5-Megapixel Xenon-Blitzlichtkamera. Drücken Sie 
einfach auf den Auslöser, um die Aufnahme zu 
machen, und drücken Sie anschließend Senden, um das 
Foto an Ihre Freunde zu schicken (Informationen 
hierzu finden Sie in der Kurzanleitung).

Videos
Mit der 5-Megapixel-Digitalkamera des Telefons 
können Sie Fotos aufnehmen. Sie halten einfach drauf, 
um ein Video aufzunehmen, und laden es 
anschließend in einen Blog hoch (Informationen hierzu 
finden Sie in der Kurzanleitung).

Musik
So geben Sie Musikdateien auf dem Telefon wieder:

  

1 Laden Sie Musik auf den Computer.

2 Übertragen Sie die Musikdateien vom Computer 
auf das Telefon.

3 Verwenden Sie den Musik-Player, um Musikdateien 
auf dem Telefon abzuspielen und zu verwalten.

1. Musik auf den Computer laden
Um auf Ihrem Computer eine Musikbibliothek zu 
erstellen, können Sie durch Microsoft™ Windows™ 
Media DRM geschützte Musikdateien in unterstützten 
Online-Music-Stores (wie z. B. Urge, Yahoo und 
Napster) kaufen.
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Sie können auch Musikdateien von einer Musik-CD 

auf den Computer laden:

  

1 Legen Sie die Musik-CD in das CD-Laufwerk des 
Computers ein.

2 Starten Sie Windows Media Player 11.

3 Kopieren Sie die Musik-CD in die Media 
Player-Bibliothek (auch CD-Ripping genannt).

Falls der Computer mit dem Internet verbunden ist, 
kann der Media Player Informationen wie z. B. Titel, 
Albumname, Interpret und Cover des Albums abrufen. 
Diese Informationen werden im Musik-Player des 
Telefons angezeigt.

Informationen zum Verringern der Größe der 
Musikdatei oder zum Konvertieren von 
iTunes-Musikdateien in ein mit Microsoft™ 
Windows™ Player 11 kompatibles Format finden Sie 
auf Seite 40.

2. Musik auf das Telefon 
übertragen
Mit Windows Media Player 11 können Sie Musik vom 
Computer auf das Telefon übertragen. (Windows 
Media Player 11 können Sie ggf. unter 
www.microsoft.com/windowsmedia herunterladen.)

Windows Media Player 11 benötigt Windows XP™ 
oder höher. Wenn Sie eine frühere Version des 
Windows-Betriebssystems verwenden, finden Sie 
Informationen zum manuellen Übertragen von Musik 
auf Ihr Mobiltelefon auf Seite 42.

Mit Windows Media Player 11 können Sie nur 
Musikdateien auf die Speicherkarte Ihres Telefons 
kopieren und synchronisieren. Informationen zum 
Kopieren von Dateien in den Telefonspeicher und zum 
manuellen Übertragen von Musik auf Ihr Mobiltelefon 
finden Sie auf Seite 42.
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Hinweis: Mit Windows Media Player 11 können Sie 

nur Musikdateien auf die Speicherkarte Ihres Telefons 
kopieren und synchronisieren. Sie können Windows 
Media Player 11 nicht verwenden, um Bilder oder 
Videos auf das Telefon zu übertragen.

Telefon:

Stecken Sie eine Speicherkarte in das Telefon (siehe  
Kurzanleitung), und drücken Sie anschließend s 
> u Setup > Verbindungen > USB-Einstellung > Mediadatei-Synchr.

Schließen Sie das Motorola 
Original-USB-Kabel an den 
Micro USB-Anschluss des Telefons und 
an einen freien USB-Anschluss an Ihrem 
Computer an. Ein Motorola Original-USB-Kabel und 
die zugehörige Software sind ggf. im Lieferumfang 
des Telefons enthalten. Dieses Zubehör ist auch 
separat erhältlich.

Hinweis: Einige Telefonfunktionen sind 

vorübergehend nicht verfügbar, wenn eine 
USB-Verbindung besteht.

Computer:

Führen Sie Windows Media Player 11 aus. Ihr Telefon 
wird in der rechten oberen Ecke des Bildschirms von 
Windows Media Player 11 angezeigt, die auf der 
Speicherkarte des Telefons gespeicherten 
Musikdateien werden links im Bildschirm angezeigt.
  

1 Wählen Sie im Windows Media Player 11 die 
Registerkarte „Synchronisieren“.

2 Ziehen Sie die Musiktitel oder Playlisten mit 
Drag-and-Drop auf die Synchronisierungsliste 
rechts im Bildschirm von Windows Media 
Player 11.

3 Klicken Sie auf „Sync starten“, um die Musiktitel 
auf die Speicherkarte des Telefons zu kopieren.

4 Trennen Sie anschließend das Telefon vom 
Computer.
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3. Musik abspielen
Zu finden unter: s > j Multimedia > Media Finder 
> Musikbibliothek

Aus folgenden Kategorien können Sie einen Musiktitel 
oder eine Playliste auswählen: Kürzlich abgespielt, 
Zufallswiedergabe der Titel (Musiktitel in einer zufälligen 
Reihenfolge wiedergeben), Alle Lieder, Playlisten, Künstler, 
Alben, Genres oder Komponisten.

Hinweis: Wenn Sie während der Musikwiedergabe 

einen Anruf erhalten, wird der Musiktitel angehalten, 
bis der Anruf beendet wird.

Musik-Player
Hinweis: Das unbefugte Kopieren von 
urheberrechtlich geschützten Materialien verstößt 
gegen die Bestimmungen des Urheberrechtsgesetzes 
der USA und anderer Länder. Dieses Gerät darf nur 
zum Kopieren von nicht urheberrechtlich geschützten 

Materialien verwendet werden sowie von Materialien, 

für die Sie über das Urheberrecht verfügen, oder von 
Materialien, für die Sie über eine Befugnis oder 
gesetzliche Berechtigung zum Kopieren verfügen. 
Wenn Sie nicht sicher sind, welche Rechte Sie im 
Hinblick auf das Kopieren von Materialien haben, 
holen Sie sich juristischen Rat ein.

So legen Sie das Standardformat für 
Audiodateien und die Bitrate fest:
Microsoft™ Windows™ Media Player 11 ermöglicht 
Ihnen das Anpassen der Format- und 
Bitrateneinstellungen zur Optimierung der Tonqualität 
oder Erhöhung der Anzahl an Musiktiteln, die Sie auf 
dem Mobiltelefon speichern können.

Das Windows Media Audio-Format ermöglicht das 
optimale Gleichgewicht zwischen Dateigröße und 
Tonqualität. Musikdateien in diesem Format benötigen 
mehr Speicherplatz als Dateien im Windows Media 
Audio Pro-Format.
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Das Windows Media Audio Pro-Format wurde für die 

Verwendung in tragbaren Geräten mit begrenzter 
Speicherkapazität konzipiert. Das Format bietet eine 
verbesserte Tonqualität bei niedrigeren Bitraten.

So legen Sie das Standarddateiformat und die Bitrate 
fest:

  

1 Legen Sie die Musik-CD in das CD-Laufwerk des 
Computers ein.

2 Starten Sie Windows Media Player 11.

3 Wählen Sie in Windows Media Player 11 die 
Registerkarte „Von Medium kopieren“.

4 Klicken Sie auf der Registerkarte „Von Medium 
kopieren“ auf den Pfeil nach unten, und wählen 
Sie Format > Windows Media Audio oder 
Windows Media Audio Pro.

5 Klicken Sie erneut auf der Registerkarte „Von 
Medium kopieren“ auf den Pfeil nach unten, und 
wählen Sie Bitrate > Bitrate.

iTunes AAC-Dateien in 
MP3-Dateien auf dem Computer 
umwandeln:
Verwenden Sie die iTunes-Desktopanwendung, um 
iTunes-AAC-Standarddateien in MP3-Dateien 
umzuwandeln, die mit Windows Media Player 11 
kompatibel sind.

Hinweis: Mit der iTunes-Desktopanwendung können 
Sie nur AAC-Dateien umwandeln, die von einer 
Musik-CD gerippt wurden. Sie können mit dieser 
Anwendung keine Musikdateien umwandeln, die Sie 
über den iTunes Store erworben haben.

  

1 Starten Sie die iTunes-Desktopanwendung auf 
dem Computer.

2 Wählen Sie Bearbeiten > Einstellungen, klicken 
Sie auf die Registerkarte „Erweitert“, und klicken 
Sie auf „Importieren“.
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3 Öffnen Sie das Popup-Menü „Importieren mit“, 

und wählen Sie die Option „MP3-Codierer“. 
Klicken Sie auf OK, um die Einstellungen zu 
speichern.

4 Wählen Sie mindestens ein Lied in der 
iTunes-Musikbibliothek. Wählen Sie anschließend 
Erweitert > Auswahl in MP3 konvertieren.

Die umgewandelten MP3-Dateikopien werden in der 
Musikbibliothek des Computers zusammen mit den 
AAC-Originaldateien angezeigt.

Musik manuell auf das Telefon 
oder die Speicherkarte übertragen
Sie können auch ohne Windows Media Player 11 das 
Telefon an einen Computer anschließen und manuell 
Musikdateien vom Computer in den Telefonspeicher 
oder auf eine optionale microSD-Speicherkarte im 
Telefon kopieren bzw. eine Synchronisation 

vornehmen. (Informationen zum Einsetzen einer 

Speicherkarte finden Sie in der Kurzanleitung.)

Unterstützte Audioformate

Bevor Sie Audiodateien auf das Telefon kopieren, 
müssen Sie sicherstellen, dass das Dateiformat vom 
Telefon erkannt wird: AMR-NB, AMR-WB, AAC 
(MPEG4 AAC-LC), AAC+, Enhanced AAC+, MP3, 
8-Bit-Linear PCM, 16-Bit-Linear PCM, 8-Bit A-Law 
PCM, 8-Bit mu-Law PCM, WMA v9 L2 (auch WMA v3, 
v7, v8), Real Audio LBR (Cook), Real Audio Sipro 
(ACELP®.net), Real Audio 10 und Windows Media 
Audio Pro.

Telefon:

Drücken Sie s > u Setup > Verbindungen > USB-Einstellung 
> Speicherkarte

Schließen Sie das Motorola Original-USB-Kabel 
an den Micro USB-Anschluss des Telefons und 
an einen freien USB-Anschluss an Ihrem 
Computer an. 
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Ein Motorola Original-USB-Kabel und die zugehörige 

Software sind ggf. im Lieferumfang des Telefons enthalten. 
Dieses Zubehör ist auch separat erhältlich.

Computer:

Das Telefon und die Speicherkarte werden als 
Wechseldatenträger auf dem Computer angezeigt.

  

1 Suchen Sie das Wechseldatenträgersymbol für 
das Telefon und die Speicherkarte. Bei einem 
Windows PC finden Sie das Symbol im Fenster 
„Arbeitsplatz“. Auf einem Macintosh®-Computer 
befindet sich das Symbol auf dem Desktop.

2 Doppelklicken Sie auf das 
Wechseldatenträgersymbol für das Telefon oder 
die Speicherkarte.

3 Um die gewünschten Dateien auf das Telefon 
oder die Speicherkarte zu kopieren, ziehen Sie sie 
mit Drag-and-Drop auf das entsprechende 
Wechseldatenträgersymbol.

4 Trennen Sie anschließend das Telefon 

ordnungsgemäß vom Computer.

• Auf einem PC klicken Sie mit der rechten 
Maustaste in der Taskleiste unten auf dem 
Computerbildschirm auf das Symbol 
„Hardware sicher entfernen“ und wählen 
anschließend „USB-Massenspeicher“ aus.

• Wenn Sie mit einem Mac arbeiten, ziehen 
Sie das Wechseldatenträgersymbol auf den 
Papierkorb.
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Musik abspielen
Mit der Navigationstaste S steuern Sie die 
Wiedergabe der Musiktitel.

Drücken Sie während der Musikwiedergabe Optionen, 

um die Musik-Player-Optionen auszuwählen.

Album-
Cover

Zurück zum vorherigen 
Bildschirm

Musik-Player-Optionen 
auswählen und anpassen

10/10/2008--910 Kb

titel.name

01:15 02:40

Optionen Zurück

Musiktitel
Interpret
Album

Timer zeigt 
abgespielte Zeit 

in % an.

Drücken Sie S, um die Wiedergabe 
anzuhalten bzw. zu starten, und drücken Sie 
unten, um sie zu stoppen. Drücken Sie S 
links/rechts, um zum vorherigen/nächsten 

Musiktitel zu springen.

Optionen

Ausblenden Musik-Player während der 
Wiedergabe von Musik ausblenden. 
Um den Musik-Player wieder 
einzublenden, drücken Sie im 
Standby-Display S nach oben.

Verwalten Eigenschaften des Musiktitels, z. B. 
Dateiname, Typ und Größe 
anzeigen.

Löschen Musikdatei löschen

Senden an Musiktitel in einer Nachricht oder 
E-Mail senden oder über eine 
Bluetooth®-Verbindung an eine 
Speicherkarte oder ein anderes 
Gerät senden.

Verwenden als Musiktitel zu einer Playliste hinzufügen 
oder zu einem Klingelton konvertieren
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Während der Musikwiedergabe zeigt der Musik-Player 

gegebenenfalls Musiktitel, Interpret, Album und Cover 
an. Um ein größeres Bild des Covers anzuzeigen, 
drücken Sie s (drücken Sie s erneut, um zum 
Musik-Player zurückzukehren).

Playliste wiedergeben
Zu finden unter: s > j Multimedia > Media Finder 
> Musikbibliothek > Playlisten, blättern Sie zu der Playliste, 
drücken Sie Optionen > Abspielen

Playliste erstellen

Playliste auf einem Computer erstellen

Verwenden Sie Windows Media Player 11 (oder das 
Programm für die Medien-Wiedergabe auf dem 
Computer), um eine Playliste mit auf Ihrem Computer 
gespeicherten Musikdateien zu erstellen.

Drücken Sie auf dem Telefon s > u Setup 
> Verbindungen > USB-Einstellung > Speicherkarte.

Bluetooth verw./ 
Mobiltelefon verw.

Um eine Audiodatei an ein 
Bluetooth-Headset zu senden, 
aktivieren Sie die 
Bluetooth-Funktion und wählen 
Bluetooth verw., um eine Verbindung zu 
einem erkannten Bluetooth-Headset 
herzustellen oder nach einem neuen 
Headset zu suchen.

Wählen Sie bei aktivierter 
Bluetooth-Audioverbindung 
Mobiltelefon verw., um die 
Bluetooth-Verbindung zu trennen 
und den Ton wieder auf das Telefon 
umzuleiten.

Hinweis: Diese Option wird nur 
angezeigt, wenn Bluetooth aktiviert ist.

Setup Einstellungen anpassen

Optionen
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Schließen Sie das Telefon über eine 

USB-Kabelverbindung an den Computer an, und 
ziehen Sie die Playliste auf das Telefon oder die 
Speicherkarte, und legen Sie sie dort ab.

Playliste auf dem Telefon erstellen

Zu finden unter: s > j Multimedia > Media Finder 
> Musikbibliothek > Playlisten > Neue Playliste erstellen

  

1 Geben Sie einen Namen für die Playliste ein.

2 Geben Sie einen Speicherort für die Playliste ein 
(Speicherkarte oder Telefonspeicher), drücken Sie dann 
Speichern.

3 Blättern Sie zur Playliste, und drücken Sie s, um 
sie auszuwählen.

4 Blättern Sie zu Musiktitel hinzufügen, und drücken Sie 
zur Auswahl die mittlere Taste s.

5 Ihr Mobiltelefon zeigt die Musikbibliotheksliste 
an. Wählen Sie Alle Lieder und blättern Sie 
anschließend zu den Musikstücken, die Sie 

hinzufügen wollen, und drücken Sie zum 

Auswählen s.

6 Drücken Sie Hinzufügen, um sie dann zur Playliste 
hinzuzufügen.

7 Wiederholen Sie diese Schritte, um weitere Titel 
hinzuzufügen, oder drücken Sie Zurück, um zum 
Menü Playlisten zurückzukehren.

Audioeinstellungen anpassen
Sie können die Audioeinstellungen des Telefons 
anpassen, um bei der Musikwiedergabe über 
Lautsprecher, Stereokopfhörer oder Headset eine 
optimale Soundqualität zu erreichen.

Zum Ändern der Wiedergabelautstärke drücken Sie 
die Lautstärketasten seitlich am Telefon.

Zum Anpassen der Equalizer-Einstellungen drücken 
Sie Optionen > Einrichten > Equalizer > Musikstil.
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Um die Stereotrennung festzulegen, drücken Sie 

Optionen > Einrichten > Raumklang > Trennungsgrad.

Um den Bass Boost festzulegen, drücken Sie Optionen 
> Einrichten > Bass Boost > Bass-Stärke.

Bluetooth®-Stereokopfhörer 
verwenden
Verbinden Sie das Telefon mit den optionalen 
Bluetooth-Stereokopfhörern, um die auf dem 
Telefon gespeicherte Musik zu hören.

Bevor Sie das Mobiltelefon an die 

Bluetooth-Stereokopfhörer anschließen, müssen 
Sie sicherstellen, dass die Kopfhörer eingeschaltet 
und betriebsbereit sind und sich im Koppel- bzw. 
Verbindungsmodus befinden (siehe 
Benutzerhandbuch für das jeweilige Gerät).

Zu finden unter: s > u Setup > Verbindungen 
> Bluetooth > Nach Geräten suchen > Headset

Das Telefon listet die Bluetooth-Audiogeräte auf, die 

es innerhalb seiner Reichweite findet.

  

1 Blättern Sie zu den gewünschten 
Stereokopfhörern in der Liste.

2 Drücken Sie s, um eine Verbindung mit den 
Stereokopfhörern herzustellen.

Musik-Player anpassen
Zu finden unter: s > j Multimedia > Media Finder 
> Musikbibliothek drücken Sie Optionen > Einrichten

Sie können folgende Optionen auswählen:

Optionen

Zufällige Wiederg. Musiktitel in einer zufälligen 
Reihenfolge wiedergeben

Equalizer Stellen Sie den Equalizer auf einen 
Musikstil ein wie z. B. Klassik.
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Wenn Sie zu einem Musiktitel in einer Liste blättern 
und Optionen drücken, werden möglicherweise 
zusätzliche Optionen für den Musiktitel und die Liste 
angezeigt, wie z. B. Löschen, Senden an und Verwenden als.

Musik-Player schließen
Drücken Sie im Musik-Player- oder im 
Standby-Display O, um den Musik-Player zu 
schließen.

UKW-Radio
Sie können mit Ihrem Telefon 
UKW-Radiostationen hören. Sie können 
das im Lieferumfang enthaltene 
Motorola Original-Stereoheadset oder die 
Freisprecheinrichtung verwenden, um mit dem 
Telefonradio zu hören.

Hinweis: Sie müssen ein Headset mit 

Kabelanschluss in den Headset-Anschluss Ihres 

Telefons einstecken, um das Radio zu verwenden. 
Das Headset dient als Radioantenne, um die 
Radiowellen zu empfangen. Über ein 
Bluetooth®-Headset ist kein Radioempfang möglich.

Autom. Wiederh. Den Musiktitel oder die Playliste 
erneut wiedergeben, sobald die 
Wiedergabe der letzten Datei 
beendet ist

Raumklang Einstellen, um den Ton anzupassen

Bass Boost Einstellen, um den Ton anzupassen

Internetverbind. Legen Sie Ihre 
Internet-Verbindungsein- 
stellungen fest.

Optionen
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Zu finden unter: s > j Multimedia > UKW-Radio

So ändern Sie die Radiolautstärke: Drücken Sie die 
Lautstärketasten seitlich am Telefon.

So speichern Sie einen voreingestellten Sender: 

Halten Sie eine Zifferntaste gedrückt (1 bis 9), 
um dem aktuell eingestellten Sender eine Nummer 
zuzuweisen. Sie können bis zu neun Sender für jeden 
der drei getrennten FM-Frequenzbereiche 
voreinstellen (weitere Informationen dazu finden Sie 
im folgenden Abschnitt).

So wählen Sie einen gespeicherten, 

voreingestellten Sender: Drücken Sie die Zifferntaste, 
um den entsprechenden Sender auszuwählen.

Hinweis: Wenn Sie einen Anruf erhalten, während das 
Radio läuft, drücken Sie Antworten. Drücken Sie O, um 
den Anruf zu beenden und wieder das Radio zu 
aktivieren.

S links/rechts drücken, 
um zur vorherigen/nächsten 

Frequenzeinstellung zu 
wechseln

S oben/unten drücken, 
um zur nächsten/ 

vorherigen Voreinstellung 
zu wechseln

Radiosendefrequenz, 
Frequenzband und 

voreingestellte Nummer

FM-Radio-Optionen 
auswählen und anpassen

Optionen Zurück

UKW-Radio

93.70 FM
FM 1 Voreinstellung 1
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UKW-Radiooptionen
Drücken Sie im UKW-Radiobildschirm Optionen, um die 
Radiooptionen auszuwählen:

Optionen

Ausblenden Radio ausblenden.

Um wieder das Radio-Display 
anzuzeigen, drücken Sie s > 
j Multimedia > UKW-Radio, oder 
drücken Sie vom 
Standby-Display aus S nach 
oben.

Stumm/Nicht stumm Radio stumm schalten und 
Stummschaltung aufheben.

Schnellzugriff: Drücken Sie im 
Radiodisplay *, um das Radio 
stummzuschalten oder die 
Stummschaltung wieder 
aufzuheben.

Zu Lautsprecher 

wechseln/Zu Headset 

wechseln

Schalten Sie den Ton zum 
Telefonlautsprecher oder zum 
angeschlossenen Headset um.

Band wechseln Schalten Sie zwischen den 
Frequenzbereichen FM 1, FM 2 und 
FM 3 um. Für jeden 
Frequenzbereich können bis zu 
neun voreingestellte Sender 
gespeichert werden (wählen Sie 
die voreingestellten Sender 
durch Drücken der Zifferntasten 
1-9 aus.

Schnellzugriff: Drücken Sie im 
Radiodisplay #, um zwischen 
den Frequenzbereichen zu 
wechseln.

Optionen
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Schalten Sie das UKW-Radio aus.
Drücken Sie im UKW-Radio- oder 
Standby-Display O, um das Radio abzuschalten.

Browser
Verwenden Sie den HTML-Browser des Telefons, um Ihre 
Webseiten aufzurufen, Videos auf ein Videoblog zu laden 
und Dateien und Anwendungen auf das Telefon 
herunterzuladen. Melden Sie sich bei Ihrem 
Internet-E-Mail-Konto an, um Ihre E-Mail unterwegs 
abzurufen.

So starten Sie den Browser:

Zu finden unter: s > 1 Web-Zugriff > Browser

Drücken Sie S oben, unten, links oder rechts, um 
durch die Webseiten zu blättern. Blättern Sie zu einem 
Link, und drücken Sie s, um ihn auszuwählen. 
Drücken Sie zu einem beliebigen Zeitpunkt Zurück, um 
zum vorherigen Bildschirm zurückzukehren.

Einige Webseiten können ein Texteingabefenster für 
den Austausch von Informationen mit einer Webseite 
enthalten. Blättern Sie zu einem Fenster, wählen Sie 
es aus, und geben Sie den Text wie gewohnt ein 
(weitere Informationen zur Texteingabe finden Sie auf 
Seite 17).

Scannen Hören Sie bei jedem Sender, 
den das Telefon empfangen 
kann, kurz hinein. Drücken Sie 
s, um das Scannen 
anzuhalten.

Voreinstellungen 

scannen

Hören Sie kurz bei jedem 
voreingestellten Sender hinein. 
Drücken Sie s, um das 
Scannen anzuhalten.

Voreinstellungsliste Siehe Liste der voreingestellten 
Sender.

Optionen
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Um eine Webseite aufzurufen, drücken Sie Optionen 
> URL aufrufen, geben die Internetadresse ein und 
drücken anschließend Start.

Um ein Lesezeichen in die aktuelle Webseite 
einzufügen, drücken Sie Optionen > Aktuelle Seite 
> Bookmark hinzufügen.

Um eine Webseite mit einem Lesezeichen 
aufzurufen, drücken Sie Optionen > Bookmarks 
> Lesezeichen.

Um die Startseite zu ändern, die angezeigt wird, 
wenn Sie den Browser starten, rufen Sie die 
gewünschte Webseite auf, drücken Sie Optionen 
> Aktuelle Seite > Als Homepage verwenden.

Informationen zum Hochladen eines Videos auf eine 
Blogsite finden Sie in der Kurzanleitung.

Zum Herunterladen einer Mediadatei, eines Themes 
oder eines Java™-Spiels bzw. einer 
Java™-Anwendung auf Ihr Telefon rufen Sie die Seite 
auf, die mit der Datei verknüpft ist, blättern zu dem 
Link, und wählen ihn aus.

Um den Browser zu beenden, drücken Sie Optionen 
> Beenden.

Browser-Einstellungen
Für die Verwendung des Browsers Ihres Mobiltelefons 
muss dieser entsprechend für den Internetzugang 
konfiguriert werden. Zudem muss der Datendienst für 
Ihr Konto durch Ihren Diensteanbieter aktiviert 
werden. (Für diesen Dienst können zusätzliche 
Gebühren anfallen.)

Falls erforderlich, erhalten Sie die nötigen 
Informationen zur Einstellung des Internetbrowsers 
für Ihr Mobiltelefon direkt von Ihrem Diensteanbieter, 
oder besuchen Sie die folgende Website:

https://hellomoto.wdsglobal.com/site/phonefirst

Hinweis: Über die Website stehen möglicherweise 
nicht alle Einstellungen des Diensteanbieters zur 
Verfügung.
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Nachrichten

Textnachrichten

Nachrichten senden
Eine Nachricht kann Text, Bilder, Musik oder 
andere Multimediadateien enthalten. Sie 
können mehrseitige Nachrichten verfassen und auf 
jeder Seite Text und Multimediadateien einfügen. 
Die fertige Nachricht kann an kompatible Telefone 
oder E-Mail-Adressen gesendet werden.

 Zu finden unter: s > g Nachrichten > Nachricht 

erstellen

 

1 Geben Sie den Text mithilfe der Tastatur ein. 
(Weitere Informationen zur Texteingabe finden 
Sie auf Seite 17.)

Um ein Objekt (Bild, Sound oder eine andere 
Mediendatei) in die Seite einzufügen, drücken Sie 
Optionen > Einfügen. Wählen Sie den Dateityp und die 
Datei. (Hinweis: Möglicherweise gelten für Bilder 
und Videoclips, die Sie in einer Nachricht senden, 
Dateigrößenbeschränkungen.)

Um eine weitere Seite einzufügen, drücken Sie 
Optionen > Einfügen > Seite. Auf der neuen Seite 
können Sie weiteren Text und weitere Objekte 
hinzufügen.

2 Wenn Sie die Nachricht fertig gestellt haben, 
drücken Sie Optionen > Sendeoptionen, um 
Nachrichtenoptionen (z. B. Betreff und Priorität) 
festzulegen:
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3 Drücken Sie nach dem Auswählen der 

Nachrichtenoptionen Fertig.

4 Drücken Sie Senden an, um die 
Nachrichtenempfänger auszuwählen. Sie haben 
folgende Möglichkeiten:

• Wählen Sie mindestens einen Eintrag aus der 
Kontaktliste aus (drücken Sie S, um zu 
einem Eintrag zu blättern, und drücken Sie 
s, um den Eintrag auszuwählen).

• Geben Sie eine neue Nummer oder 
E-Mail-Adresse ein (drücken Sie Optionen 
> Rufnummer eingeben oder E-Mail eingeben).

5 Drücken Sie Senden, um die Nachricht zu senden.

Möglicherweise erhalten Sie die Meldung, dass 
es sich um eine Multimedia- bzw. MMS-Nachricht 
handelt, wenn mehrere Seiten oder Mediadateien 
vorhanden sind. Nicht alle Telefone oder Netze 
unterstützen MMS-Nachrichten. Drücken Sie Ja, 
um die Nachricht zu senden.

Um die Nachricht zu speichern oder abzubrechen, 
drücken Sie Optionen > In Entwürfe speichern oder 
Nachricht abbrechen.

Nachrichten empfangen
Wenn Sie eine Nachricht erhalten, ertönt ein 
Signalton, und auf dem internen Display wird 
Nachricht erstellen zusammen mit dem 
Nachrichtensymbol ] angezeigt.

Drücken Sie zum Lesen der Nachricht Anzeigen. Falls die 
Nachricht Multimediadateien enthält:

• Beim Lesen der Nachricht werden Bilder und 
Animationen angezeigt.

• Beim Lesen der Nachricht werden 
Sounddateien wiedergegeben. Drücken Sie 
die externen Lautstärketasten seitlich am 
Telefon, um die Lautstärke zu ändern.

• Angehängte Dateien befinden sich am Ende 
der Nachricht. Um einen Anhang zu öffnen, 
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wählen Sie das Dateisymbol oder den 

Dateinamen aus.

Um die Nachricht zu beantworten, drücken Sie Optionen 
> Antworten.

Falls noch ungelesene Nachrichten vorliegen, wird das 
Symbol W angezeigt. Drücken Sie Schnellzugriffstasten > 
Benachrichtigungen anzeigen, um die Nachrichten zu lesen, und 
drücken Sie Löschen, um sie zu löschen.

Weitere Nachrichten- und 
E-Mail-Funktionen

Funktionen

Bestätigung, dass eine Nachricht gesendet 

wurde

So bestätigen Sie, dass Ihre Nachricht gesendet 
wurde:

s > g Nachrichten > Ausgang > Nachricht

In Ihrem Mobiltelefon werden die 
Nachrichtenempfänger aufgelistet und der Status 
der Nachricht angezeigt. Gesendet gibt an, dass die 
Nachricht erfolgreich gesendet wurde, Fehler 
bedeutet, dass die Nachricht nicht gesendet wurde.
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Textvorlage senden

s > g Nachrichten > Vorlagen > Textvorlagen 
> Vorlage, drücken Sie Optionen > Senden

So erstellen Sie eine neue Textvorlage:

s > g Nachrichten > Vorlagen > Textvorlagen, drücken Sie 
Optionen > Vorlage erstellen

E-Mail-Konten einrichten

Mehrere E-Mail-Konten im Telefon einrichten 
und verwenden:

s > g Nachrichten > E-Mail > Konto hinzufügen

Hinweis: Das Display zeigt einen separaten Ordner 
für jedes E-Mail-Konto an.

E-Mail senden

s > g Nachrichten > E-Mail

Funktionen

MMS-Vorlage verwenden

MMS-Vorlage mit vorinstallierten 
Mediendateien öffnen:

s > g Nachrichten > Vorlagen > MMS-Vorlagen

Neue Nachricht oder E-Mail lesen

Wenn im Display Neue Nachricht angezeigt wird, 
drücken Sie Lesen.

Alte Nachrichten lesen

s > g Nachrichten > Eingang

Symbole neben den einzelnen Nachrichten 
kennzeichnen deren Status gelesen >, 
ungelesen ], dringend < oder mit Anhang *. 
Drücken Sie Optionen, um eine Nachricht weiter zu 
bearbeiten.

Funktionen
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Alte E-Mails lesen

s > g Nachrichten > E-Mail

Drücken Sie Optionen, um eine Nachricht weiter zu 
bearbeiten.

Nachrichtenobjekte speichern

Blättern Sie zur betreffenden Seite in der 
MMS, und drücken Sie Optionen > Speichern.

Ordner erstellen

Erstellen Sie einen persönlichen Ordner zum 
Speichern Ihrer Nachrichten.

s > g Nachrichten > Meine Ordner, drücken Sie Optionen 
> Ordner erstellen

Funktionen

Browser-Nachrichten

Mit dem Browser empfangene Nachrichten 
lesen:

Wenn im Display Neue Nachricht angezeigt wird, 
drücken Sie Anzeigen.

So aktivieren Sie Browser-Nachrichten und passen 
die Einstellungen für Browser-Nachrichten an:

s > g Nachrichten, drücken Sie Optionen > Einstellungen 
> Browser-Nachr.

Funktionen
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Cell Broadcast

Abonnierte Cell Broadcast-Nachrichten 
anzeigen:

Wenn im Display Neue Nachricht angezeigt wird, 
drücken Sie Anzeigen.

So aktivieren Sie Cell Broadcast und passen die 
Einstellungen hierfür an:

s > g Nachrichten, drücken Sie Optionen > Einstellungen 
> Cell Broadcast

Funktionen
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Verbindungen

Sync
Zum Synchronisieren von Informationen zwischen 
Ihrem Telefon und einem Remote-Server können 
Sie Sync verwenden.

Sync mit SyncML
Sie können einen SyncML-Internet-Server anrufen 
und die Kontaktliste und Kalendereinträge Ihres 
Telefons mit dem Server synchronisieren.

So synchronisieren Sie Dateien mit einem von Ihnen 
eingerichteten Partner:

Zu finden unter: s > m Tools > Sync > SyncML

Wenn kein SyncML-Profil auf dem Telefon gespeichert 
ist, werden Sie aufgefordert, ein Profil zu erstellen. 

Wenden Sie sich an Ihren IT-Systemadministrator, um 
die erforderlichen Informationen zum Einrichten eines 
Profils zu erhalten.

Hinweis: Wenn das Telefon keine Verbindung zum 
Server herstellen kann, vergewissern Sie sich, ob der 
Diensteanbieter Ihres Telefonnetzes den Datendienst 
für Ihr Telefon aktiviert hat (möglicherweise fällt für 
diesen Service eine zusätzliche Gebühr an).

Dateimanager
Verwalten Sie Musik- und Audiodateien, Fotos, 
Videoclips und andere auf Ihrem Telefon oder auf einer 
optionalen auswechselbaren MicroSD-Speicherkarte 
vorhandene Dateien.
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Zu finden unter: s > m Tools > Datei-Manager

Wählen Sie einen Ordner oder Speicherkarte aus, um den 
Inhalt anzuzeigen.

Um eine Sounddatei oder ein Sprachmemo 
wiederzugeben oder ein Foto oder Video anzuzeigen, 
blättern Sie zu der betreffenden Datei und wählen sie aus.

Um eine Datei zu bearbeiten, blättern Sie zu der Datei 
und drücken Sie Optionen > Verwalten, um sie zu kopieren, 
zu verschieben oder umzubenennen. Außerdem 
stehen Ihnen Optionen zum Löschen, Verschicken 
oder Anwenden der Datei zur Verfügung. Einige 
Funktionen können bei bestimmten urheberrechtlich 
geschützten oder vorinstallierten Dateien nicht 
ausgeführt werden.

Zum Kopieren von Dateien zwischen dem Telefon 
und einem Computer können Sie eine 
Kabelverbindung (siehe nächsten Abschnitt) oder eine 
Bluetooth®-Verbindung (siehe Seite 65) verwenden.

Speicherkarte formatieren
So formatieren Sie die Speicherkarte oder zeigen die 
Eigenschaften der Speicherkarte (z. B. Name und 
verfügbarer Speicherplatz) an:

 Zu finden unter: s > m Tools > Datei-Manager

 

1 Drücken Sie S, um zur Speicherkarte zu 
blättern.

2 Drücken Sie Optionen > Speicherkarte 
> Formatieren oder Eigenschaften.

Dateien zwischen Telefon und 
Speicherkarte verschieben oder 
kopieren
Vorsicht: Wenn Sie eine Datei an einen neuen 
Speicherort verschieben, wird die Datei am 
ursprünglichen Speicherort gelöscht.

Zu finden unter: s > m Tools > Datei-Manager
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3 Blättern Sie zu der Datei, die Sie verschieben oder 
kopieren möchten.

4 Drücken Sie Optionen > Verwalten > Verschieben oder 
Kopieren.

Hinweis: Die Optionen Verschieben und Kopieren 
werden nicht angezeigt, wenn die Datei 
urheberrechtlich geschützt ist.

5 Blättern Sie zum Zielspeicherort, und drücken Sie 
Platzieren.

Kabelverbindungen
Um Daten 
zwischen dem 

Telefon und einem 
Computer zu übertragen, 
schließen Sie den Micro 
USB-Stecker eines 
USB-Kabels an den Micro 

USB-Anschluss des Telefons an. Schließen Sie das 

andere Ende des Kabels an den Computer an.

Hinweis: Ein Motorola Original-USB-Kabel 
und die zugehörige Software sind ggf. im 
Lieferumfang des Telefons enthalten. 
Dieses Zubehör ist auch separat erhältlich. 
Überprüfen Sie Ihren Computer auf den erforderlichen 
Kabeltyp.

Hinweis: Einige Telefonfunktionen sind 
vorübergehend nicht verfügbar, wenn eine 
USB-Verbindung besteht.

So übertragen Sie Bilder zwischen Ihrem Telefon und 
Ihrem Computer: Drücken Sie s > u Setup 
> Verbindungen > USB-Einstellung > Kodak EasyShare, und 
schließen Sie Ihr Telefon an Ihren Computer an. Das 
Display der KODAK Digitalkamera wird angezeigt. 
Wählen Sie Kodak EasyShare Software und drücken Sie OK.
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So verwenden Sie Windows Media Player 11, um 

zwischen Computer und einer in Ihrem Telefon 
eingebauten Speicherkarte Musikdateien zu 

synchronisieren: Drücken Sie s > u Setup 
> Verbindungen > USB-Einstellung > Mediadatei-Synchr. Schließen 
Sie das Telefon an den Computer an. Weitere 
Informationen finden Sie auf Seite 59.

So übertragen Sie Musik, Bilder und Videos 
manuell zwischen dem Computer und dem Telefon 
(Telefonspeicher oder installierte Speicherkarte): 
Drücken Sie s > u Setup > Verbindungen > USB-Einstellung 
> Speicherkarte, und schließen Sie das Telefon an den 
Computer an. Weitere Informationen zur manuellen 
Übertragung von Musikdateien finden Sie auf 
Seite 42.

So verwenden Sie das Telefon als Modem: Drücken 
Sie s > u Setup > Verbindungen > USB-Einstellung > Modem, 
und schließen Sie das Telefon an den Computer an.

So übertragen Sie Kontaktlisten und 

Kalendereinträge zwischen Ihrem Computer und 
dem Telefon: Drücken Sie s > u Setup > Verbindungen 
> USB-Einstellung > Modem, und schließen Sie Ihr Telefon an 
den Computer an. Führen Sie die als Zubehör 
erhältliche Anwendung „Motorola Phone Tools“ auf 
Ihrem Computer aus. Sie können die Motorola Phone 
Tools auch verwenden, um Musikdateien zwischen 
Computer und Telefon zu übertragen und zu 
synchronisieren. Weitere Informationen finden Sie in 
der Bedienungsanleitung der „Phone Tools“.

So führen Sie Datenanrufe mittels eines Computers 
aus: Drücken Sie s > u Setup > Verbindungen 
> USB-Einstellung > Modem, und schließen Sie das Telefon 
an den Computer an. Sie können den Anruf über die 
Computeranwendung tätigen oder annehmen.

Um eine neue Datenverbindung auf dem Telefon 
herzustellen, drücken Sie s > u Setup > Verbindungen 
> Datenverbind. > Neue Verbindung.
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So drucken Sie ein Bild über eine 

USB-PictBridge-Verbindung: Drücken Sie s 
> u Setup > Verbindungen > USB-Einstellung > USB-Druck, und 
schließen Sie das Telefon an einen 
PictBridge-kompatiblen Drucker an. Wählen Sie die zu 
druckenden Bilder aus, und drücken Sie Optionen 
> Drucken über > USB.

USB-Verbindung beenden
Vorsicht: Trennen Sie die Verbindung zwischen 
Mobiltelefon und Computer nicht während der 
Übertragung von Dateien.

Auf einem PC mit Windows XP™ oder höher: 
Wenn die Dateiübertragung abgeschlossen ist, 
entfernen Sie das USB-Kabel von Telefon und 
Computer.

Auf einem PC mit einer früheren Version des 

Windows-Betriebssystems: Klicken Sie in der 
Taskleiste unten auf dem Computerbildschirm auf das 
Symbol „Hardware sicher entfernen“, und wählen Sie 

dann „USB-Massenspeichergerät sicher entfernen“. 
Ziehen Sie das USB-Kabel von Mobiltelefon und 
Computer ab.

Auf einem Macintosh®-Computer: Ziehen Sie das 
Wechseldatenträgersymbol auf den Papierkorb. 
Ziehen Sie das USB-Kabel von Mobiltelefon und 
Computer ab.

Bluetooth®-Verbindung
Das Mobiltelefon unterstützt 
Bluetooth-Verbindungen. Sie können Ihr Telefon 
mit einem optionalen Bluetooth-Headset, einem 
Bluetooth-Autoeinbausatz zum Freisprechen oder mit 
Bluetooth-Stereokopfhörern verbinden, um auf dem 
Telefon gespeicherte Musik zu hören. Für den 
Dateiaustausch können Sie das Telefon mit einem 
Gerät verbinden, das Bluetooth-Verbindungen 
unterstützt. Zum Drucken von Bildern können Sie das 
Telefon mit einem Drucker verbinden, der 
Bluetooth-Verbindungen unterstützt. 
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Für den Zugang zum Internet können Sie das Telefon 

als kabelloses Bluetooth-Modem verwenden.

Um die Bluetooth-Funktion mit einem Höchstmaß 

an Sicherheit zu nutzen, sollten die Bluetooth-Geräte 
immer in einer sicheren, privaten Umgebung 
angeschlossen werden.

Die Bluetooth-Funktion des 
Mobiltelefons aktivieren oder 
deaktivieren
Die Bluetooth-Funktion des Telefons wird automatisch 
aktiviert, wenn eine Bluetooth-Funktion verwendet 
wird.

So aktivieren oder deaktivieren Sie die 
Bluetooth-Funktion:

Zu finden unter: s > u Setup > Verbindungen 
> Bluetooth, drücken Sie Optionen > Bluetooth-Setup 
> Bluetooth-Power > Ein

Hinweis: Um den Akku zu schonen und die 

Bluetooth-Sicherheit zu optimieren, stellen Sie mit 
dieser Prozedur die Bluetooth-Funktion auf Aus ein, 
wenn sie nicht verwendet wird. Ihr Mobiltelefon wird 
solange keine Verbindung mit einem anderen Gerät 
herstellen, bis Sie erneut eine Bluetooth-Funktion 
verwenden oder Bluetooth wieder auf Ein einstellen.

Bluetooth-Headset oder 
Autofreisprecheinrichtung 
verwenden
Bevor Sie das Mobiltelefon zum ersten Mal mit 

einer Freisprecheinrichtung verbinden, muss das 
Gerät eingeschaltet und betriebsbereit sein und sich 
im Verbindungsmodus bzw. Koppelmodus befinden 
(siehe Bedienungsanleitung für das jeweilige Gerät). 
Sie können das Telefon jeweils nur mit einem Gerät 
verbinden.
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Zu finden unter: s > u Setup > Verbindungen 

> Bluetooth, drücken Sie Optionen > Gerät suchen > Headset

Das Telefon listet die Bluetooth-Audiogeräte auf, die 
es innerhalb seiner Reichweite findet.

  

1 Blättern Sie zu einem Gerät in der Liste.

2 Drücken Sie s, um die Verbindung mit dem 
markierten Gerät herzustellen.

Dateien auf ein anderes Gerät 
kopieren
Sie können eine Mediendatei, einen Kontakt, einen 
Kalendertermin oder ein Lesezeichen auf ein anderes 
Telefon oder einen Computer kopieren, sofern diese 
Bluetooth unterstützen.

Hinweis: Bestimmte mit einem Kopierschutz 
versehene Objekte können nicht kopiert werden.

Bevor Sie eine Datei auf ein anderes Gerät kopieren 

können, muss das empfangende Gerät eingeschaltet 
und im Erkennungsmodus betriebsbereit sein. Stellen 
Sie außerdem sicher, dass das Gerät keine andere aktive 
Bluetooth-Verbindung aufweist.
  

1 Blättern Sie im Telefon zu dem Objekt, das Sie auf 
das andere Gerät kopieren wollen.

2 Drücken Sie Optionen, und wählen Sie Folgendes aus:

• Senden an > Bluetooth für eine Bild- oder 
Sounddatei.

• Mitteilen > Kontakt > Bluetooth für einen Kontakt.

• Freigeben an > Bluetooth für einen Termin oder ein 
Lesezeichen.

3 Wählen Sie eines der erkannten Geräte aus,

oder

wählen Sie [Nach Geräten suchen], um nach neuen 
Geräten zu suchen. Wählen Sie anschließend das 
Gerät, auf das Sie das Objekt kopieren möchten.
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4 Drücken Sie Optionen > Senden.

5 Sofern erforderlich, geben Sie den vereinbarten 
Passkey (z. B. 0000) auf dem Telefon und dem 
Gerät ein, und drücken Sie OK, um eine 
Verbindung zu dem Gerät herzustellen.

Auf dem Telefon wird Senden angezeigt, während die 
Datei übertragen wird. Wenn die Dateiübertragung 
abgeschlossen ist, wird auf dem Telefon Senden erfolgreich 
angezeigt, und Sie werden aufgefordert, OK zu drücken 
um fortzufahren.

Dateien von anderen Geräten 
empfangen
Bevor Sie eine Datei von einem anderen Gerät 

empfangen können, müssen Sie Bluetooth im 
Telefon einschalten (siehe Seite 64).

Positionieren Sie das Telefon in Reichweite (etwa 
10 Meter) des anderen Bluetooth-Geräts, und senden 
Sie die Datei vom Gerät.

Wenn Mobiltelefon und sendendes Gerät bisher noch 
nicht gekoppelt wurden, aktivieren Sie auf dem 
Telefon den Erkennungsmodus, damit es vom 
sendenden Gerät lokalisiert werden kann. Drücken Sie 
s > u Setup > Verbindungen > Bluetooth, drücken Sie 
Optionen > Auffindbar: 3 Minuten. Das Bluetooth-Symbol & im 
Standby-Display blinkt, wenn sich das Telefon im 
Erkennungsmodus befindet.

Sie werden vom Telefon benachrichtigt, sobald die 
Datenübertragung abgeschlossen ist. Die Datei wird 
gespeichert.

Foto an einen Drucker senden
Sie können ein Foto an einen Drucker senden, der 
Bluetooth-Verbindungen unterstützt.

Hinweis: Sie können Seiten im Format A4, US Letter 
und 4 x 6 drucken. Wenn Sie in anderen Formaten 
drucken möchten, müssen Sie das Bild auf einen 
verbundenen Computer kopieren und über diesen 
ausdrucken.
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1 Nehmen Sie mit dem Telefon ein neues Foto auf, 
oder blättern Sie zu einem gespeicherten Bild, 

das Sie drucken möchten. Drücken Sie dann 
Optionen > Drucken über > Bluetooth.

Hinweis: Wenn die Meldung Service nicht unterstützt 
angezeigt wird, wenn Sie versuchen zu drucken, 
wählen Sie stattdessen Senden an > Bluetooth aus. (Mit 
der Option Senden an wird kein Bildname oder 
Zeitstempel gedruckt.)

2 Wählen Sie einen bekannten Druckernamen, oder 
drücken Sie Optionen > Suche nach Druckern, um nach 
einem anderen Drucker zu suchen, an den Sie das 
Bild senden möchten.

3 Ändern Sie gegebenenfalls die Druckoptionen.

Weitere Bluetooth-Funktionen
Hinweis: Ein Gerät wird erkannt, nachdem es mit dem 
Mobiltelefon gekoppelt wurde (siehe Seite 64).

Funktionen

Koppeln mit einem erkannten Gerät.

Drücken Sie s > u Setup > Verbindungen 
> Bluetooth und S links, um die Registerkarte 
Meine Geräte auszuwählen, drücken Sie S 
oben/unten, um zum Gerätenamen zu blättern. 
Drücken Sie dann s, um die Verbindung 
herzustellen.

Verbindung mit Gerät beenden

Blättern Sie zum Namen des 
angeschlossenen Geräts, und drücken Sie s, um 
die Verbindung zu trennen.
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WiFi
Hinweis: In Frankreich können die WiFi-Funktionen 

Ihres Telefons nicht im Freien verwendet werden. 

Verwenden Sie die WiFi-Funktionen in Frankreich 

nur in geschlossenen Räumen, um widerrechtliche 

Interferenzen mit Radiosignalen zu vermeiden.

Ihr Telefon kann eine Verbindung zu WiFi-Netzen 
aufbauen, wenn Sie zu Hause, im Büro oder an 
einem Hotspot sind. Zur Verwendung von WiFi muss es 
an Ihrem Standort verfügbar sein, und Sie müssen die 
Verbindung herstellen. Stellen Sie die Verbindung von 
Ihrem Telefon zu WiFi her, um Dateien auszutauschen, 
stellen Sie zum Drucken von Bildern die Verbindung zu 

Gerät aus der Geräteliste entfernen

Blättern Sie zum Gerätenamen, und drücken 
Sie Optionen > Verwalten > Gerät entfernen.

Hinweis: Ein Gerät kann nicht aus der Geräteliste 
entfernt werden, solange das Telefon mit diesem 
Gerät verbunden ist.

Während eines Anrufs die 

Audiofunktionen zum Bluetooth-Headset 

oder Bluetooth-Autoeinbausatz weiterleiten

Drücken Sie Optionen > Bluetooth verw.

Um den Ton wieder auf das Telefon umzuleiten, 
drücken Sie Optionen > Mobiltelefon verw.

Eigenschaften eines erkannten Geräts 

bearbeiten

Blättern Sie zum Gerätenamen, und drücken Sie 
Optionen > Verwalten > Gerät bearbeiten.

Funktionen

Bluetooth-Optionen einstellen

Drücken Sie s > u Setup > Verbindungen 
> Bluetooth, drücken Sie Optionen > Bluetooth-Setup.

Funktionen
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einem Drucker mit WiFi-Unterstützung her, oder stellen 
Sie mit Ihrem Telefon eine Verbindung zum Internet her.

Hinweis: WiFi ist die bevorzugte Methode zur 
Verbindung mit dem KODAK Gallery Link, um Fotos zu 
senden. (Ausführliche Informationen hierzu finden Sie 
in der Kurzanleitung.)

WiFi einschalten
Zum Einschalten der WiFi-Funktion drücken Sie s 
> u Setup > WiFi > WiFi einrichten > WiFi-Power > Ein.

Hinweis: Um den Akku zu schonen, stellen Sie die 
Funktion WiFi-Power auf Aus ein, wenn das Gerät nicht 
verwendet wird.

WiFi-Suche
Zu finden unter: s > u Setup > WiFi 
> Verfügbare Netze

  

1 Blättern Sie zu einem Netz in der Liste und 
drücken Sie s oder Optionen > Verbinden.

2 Geben Sie die Passphrase: ein und drücken Sie 

Fortfahren. Die Passphrase wird Ihnen von Ihrem 
Netzwerkadministrator zu Hause, im Büro oder 
am Hotspot zugeteilt und ist eindeutig.

3 Zum Hinzufügen zu gespeicherten Netzen 
drücken Sie Ja oder Nein.

Hinweis: Vergewissern Sie sich, dass das WiFi-Netzwerk, zu 
dem Sie eine Verbindung aufbauen, sicher ist.

WiFi-Optionen
Zum Anzeigen gesicherter WiFi-Netze drücken Sie s 
> u Setup > WiFi > Gespeicherte Netze.

Zum Verbinden mit einem WiFi-Netz, das Sie bereits 
zuvor verwendet hatten, drücken Sie s > u Setup 
> WiFi > Schnellverbindung.

Zum Anzeigen der Details zu einer WiFi-Verbindung 
drücken Sie s >u Setup > WiFi > Aktuelle Verbindung.
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TV Out
Ihr Mobiltelefon verfügt über einen 3,5 mm TV 
Out-Anschluss, über den Sie es mit einem 
Fernsehgerät verbinden und das Display Ihres 
Telefons auf dem Fernsehschirm anzeigen können. 
Schauen Sie Ihr Lieblinsvideo an, oder zeigen Sie Ihren 
Freunden Ihre persönliche Diashow (siehe 
Kurzanleitung).

TV Out einschalten
Zum Einschalten der TV Out-Funktion des Telefons 
drücken Sie s > u Setup > Verbindungen > TV Out > Ein 
> Auswählen.

Wählen Sie eine Option aus:

Drücken Sie Abbruch , um das Display Ihres Telefons auf 
dem Fernsehgerät anzuzeigen.

Telefon-Updates
Von Zeit zu Zeit verbessern wir die Software Ihres 
Mobiltelefons, um sie auch nach dem Kauf des 
Telefons schneller und effizienter zu gestalten. Unter 
folgender Adresse können Sie nach verfügbaren 
Updates suchen: www.hellomoto.com/update

Hinweis: Software-Updates wirken sich nicht auf die 
Kontaktliste oder andere persönliche Einträge oder 
Dateien aus. Wenn Sie empfangene 
Software-Updates später installieren möchten, finden 
Sie die hierfür erforderlichen Informationen auf 
Seite 82.

Optionen

Bild-Diaschau Fotos werden auf dem 
Fernsehgerät angezeigt.

Video-Diaschau Videos werden auf dem 
Fernsehgerät im Querformat 
angezeigt.

Medien durchsuchen Media Finder wird auf dem 
Fernsehgerät angezeigt.

Optionen
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Weitere Funktionen

Telefonie-Funktionen
Funktionen

Kurzwahl

Sie können neun Rufnummern im Telefon 
speichern, die Sie durch einen einzigen Tastendruck 
anrufen können. So speichern Sie eine 
Schnellwahlnummer:

s > L Kontakte, drücken Sie Optionen > Einrichten 
> Kurzwahlliste > Schnellwahlspeicherort

Um eine Kurzwahlnummer anzurufen, halten Sie 
einfach die entsprechende Taste eine Sekunde lang 
gedrückt.

Internationale Anrufe

Zur Eingabe einer Rufnummer im Ausland 
(nur möglich, wenn Ihr Mobiltelefonvertrag 
Auslandsgespräche zulässt) halten Sie 0 
gedrückt, um die Auslandsvorwahl (durch + 
gekennzeichnet) einzufügen. Wählen Sie dann die 
Ländervorwahl und die Rufnummer mithilfe der 
Zifferntasten.
Halten eines Gesprächs

Zum Halten aller aktiven Gespräche drücken Sie 
Optionen > Halten.
Stummschalten eines Gesprächs

Um alle aktiven Anrufe stummzuschalten, drücken 
Sie Optionen > Stumm.

Funktionen
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Anklopfen

Wenn während eines laufenden Gesprächs 
ein weiterer Anruf eintrifft, werden Sie durch den 
Anklopfton auf diesen zweiten Anruf hingewiesen. 
Zum Annehmen des neuen Anrufs drücken Sie N.

• Wenn Sie zwischen den Anrufen wechseln 
möchten, drücken Sie Wechseln.

• Drücken Sie zum Zusammenführen der 
beiden Gespräche Verbind.

• Zum Beenden des gehaltenen Anrufs 
drücken Sie Optionen > Gehaltenen Anruf beenden.

So aktivieren oder deaktivieren Sie die 
Anklopffunktion:

s > u Setup > Anrufe > Gesprächsopt. > Anklopfen 
> Ein oder Aus

Funktionen

Neuer Anruf

Während eines Anrufs:

Optionen > Neuer Anruf, drücken Sie Optionen > 
Kontakte durchsuchen
Konferenzgespräch

Während eines Anrufs:

Wählen Sie die nächste Nummer, drücken Sie N 
und anschließend Optionen > Anrufe verbinden
Anruf weiterleiten

Während eines Anrufs:

Optionen > Übergabe, wählen Sie die Nummer, an die das 
Gespräch weitergeleitet werden soll, und drücken 
Sie N
Rufumleitung

Rufumleitung aktivieren oder deaktivieren:

s > u Setup > Anrufe > Anrufumleitung

Funktionen
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Anrufsperre

Einschränkungen für abgehende oder 
eingehende Anrufe festlegen:

s > u Setup > Anrufe > Anrufsperre
Telefonleitung wechseln

Wenn Sie über eine SIM-Karte mit zwei 
Rufnummern verfügen, können Sie die Leitung 
wechseln, um über Ihre andere Rufnummer Anrufe 
zu tätigen und zu empfangen:

s > u Setup > Anrufe > Gesprächsopt. > Aktive Leitung

Das Symbol für die aktive Leitung zeigt die aktive 
Telefonleitung an (siehe Abbildung auf Seite 16).

Funktionen

Feste Rufnummern

Wenn Sie diese Funktion aktivieren, können 
Sie nur die in der Liste der festen Rufnummern 
gespeicherten Nummern anrufen.

Hinweis: Sie müssen den PIN2-Code für die 
SIM-Karte eingeben, um die Funktion „Feste 
Rufnummern“ ein- oder auszuschalten. Setzen Sie 
sich mit dem Diensteanbieter in Verbindung, wenn 
Sie den PIN2-Code vergessen haben.

Aktivieren oder Deaktivieren der Funktion „Feste 
Rufnummern“:

s > u Setup > Anrufe > Feste Nummern > Ein oder Aus

Liste der festen Rufnummern verwenden:

s > m Tools > Wähldienste > Feste Rufnummern

Funktionen
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Telefonbuch
Die grundlegenden Funktionen der Kontaktliste finden 
Sie in der Kurzanleitung.

MFV-Töne

MFV-Töne aktivieren:

s > u Setup > Anrufe > Wahl-Setup > DTMF

Während eines Anrufs MFV-Töne senden:

Drücken Sie die Zifferntasten.

Funktionen

Funktionen

Neuen Kontakt hinzufügen

s > L Kontakte, drücken Sie Optionen > Kontakt erstellen

Drücken Sie S links/rechts, um die Registerkarten 
Details w, Adresse u, ID < oder Notizen x 
auszuwählen. Drücken Sie S oben/unten, um zu 
den Informationen zu blättern, die Sie ändern 
möchten. Drücken Sie dann s, um die 
Informationen auszuwählen.

Hinweis: Die Optionen zu Registerkarten sind nur 
für Kontakte verfügbar, die in Ihrem Telefon und 
nicht auf Ihrer SIM-Karte gespeichert sind.
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Kontakt anrufen

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie N zum Anrufen

Hinweis: Wenn ein Kontakt mehrere Rufnummern 
oder E-Mail-Adressen enthält, drücken Sie S 
links/rechts, um die gewünschte Nummer oder 
E-Mail-Adresse auszuwählen.

Nachricht an Kontakt senden

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Nachricht senden

Funktionen

Zusätzliche Rufnummer oder E-Mail-Adresse zu 

einem Kontakt hinzufügen

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Bearbeiten, drücken Sie S links/rechts, 
um die Registerkarte Details w zu wählen, drücken 
Sie S oben/unten, um zu einem leeren Feld für 
Nummer oder E-Mail zu blättern, drücken Sie s, um 
das Feld auszuwählen

Bild-ID für einen Kontakt festlegen

Ein Foto oder Bild zuweisen, das angezeigt wird, 
wenn der betreffende Kontakt anruft:

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Bearbeiten, drücken Sie S links/rechts, 
um die Registerkarte ID zu wählen, drücken Sie <, 
drücken Sie S oben/unten, um zu Bild-ID zu 
blättern, drücken Sie s, um die Option zu wählen.

Funktionen
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Rufton-ID für einen Kontakt festlegen

Weisen Sie einem Kontakt ein erkennbares 
Anrufsignal (Klingelton-ID) zu:

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Bearbeiten, drücken Sie S links/rechts, 
um die Registerkarte ID zu wählen, drücken Sie <, 
drücken Sie S oben/unten, um zu Signal-ID zu 
blättern, drücken Sie s, um die Option zu wählen.

Kontakt zu Kategorie zuweisen

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Bearbeiten, drücken Sie S links/rechts, 
um die Registerkarte Details zu wählen, drücken 
Sie w, drücken Sie S oben/unten, um zu Kategorie 
zu blättern, drücken Sie s, um die Option zu 
wählen.

Funktionen

Kategorieansicht anzeigen

s > L Kontakte, drücken Sie Optionen > Filtern nach

Sie können die Kontakte in einer vordefinierten 
Kategorie (Alle Kontakte, E-Mail, Familie, Freunde, Büro) oder 
Kontakte in einer von Ihnen erstellten Kategorie 
anzeigen. (Wählen Sie Kategorie erstellen.)

Verteilerliste erstellen

Kontakte zu einer Gruppennachrichtenliste oder 
E-Mail-Liste zuweisen:

s > L Kontakte, drücken Sie Optionen > Liste erstellen 
> Nachricht oder E-Mail

Funktionen
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Kontaktfotos anzeigen

Kontakte mit Bild-ID-Fotos oder als Textliste 
anzeigen:

s > L Kontakte, drücken Sie Optionen > Einrichten 
> Standardansicht > Thumbnail oder Liste

Sortierreihenfolge der Kontaktliste festlegen

s > L Kontakte, drücken Sie Optionen > Einrichten 
> Stand.sortierfolge > Vorname oder Nachname

Private Kontakte erstellen und verwenden

Kennzeichnen Sie einen oder mehrere Kontakte als 
private Kontakte. Geben Sie den sechsstelligen 
Sicherheitscode ein, um auf die privaten Kontakte in 
Ihrer Kontaktliste zugreifen zu können.

s > L Kontakte, drücken Sie Optionen > Einrichten 
> Private Kontakte

Funktionen

Kontakte in den Telefonspeicher importieren

Alle Kontakte von der SIM-Karte oder von einem 
anderen Speicherort in den Telefonspeicher 
importieren:

s > L Kontakte, drücken Sie Optionen > Kontakte import. 
> SIM-Karte oder Datei-Manager

Kontakte auf SIM-Karte verwalten

s > L Kontakte, drücken Sie Optionen > Einrichten 
> SIM-Manager

Sie können Kontakte von der SIM-Karte löschen 
oder vom Telefonspeicher oder einem anderen 
Speicherort auf die SIM-Karte importieren.

Funktionen
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Kontakte an ein anderes Gerät senden

Einen oder mehrere Kontakte an ein anderes 
Telefon, einen Computer oder ein anderes Gerät 
senden:

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Mitteilen, drücken Sie s, um den 
aktuellen Kontakt zu wählen, drücken Sie S 
oben/unten, um zum Übertragungsverfahren 
Bluetooth, Messaging oder E-Mail zu blättern. Drücken Sie 
dann Auswählen, um die Option zu wählen.

Um mehrere Kontakte zu senden, drücken Sie 
Optionen > Mitteilen > Mehrere Kontakte (statt des aktuellen 
Kontakts).

Funktionen

Kontakte löschen

Einen oder mehrere Kontakte von der Kontaktliste 
löschen:

s > L Kontakte, blättern Sie zum Kontakt, drücken 
Sie Optionen > Löschen, drücken Sie s, um den 
aktuellen Kontakt auszuwählen, drücken Sie Ja, 
um den Löschvorgang zu bestätigen.

Um mehrere Kontakte zu löschen, drücken Sie 
Optionen > Löschen > Mehrere Kontakte (statt des aktuellen 
Kontakts).

Funktionen
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Grundeinstellungen

Funktionen

Sprache

Menüsprache festlegen:

s > u Setup > Telefon > Sprache

Erinnerungen

Erinnerungssignal für Terminbenachrichtigungen 
festlegen:

s > u Setup > Profile, drücken Sie S links/rechts, 
um die Registerkarte Einstellungen # 
auszuwählen, > Erinnern

Einstellungen zurücksetzen

Zurücksetzen aller Optionen auf ihre werksseitigen 
Einstellungen, mit Ausnahme von Entsperrcode, 
Sicherheitscode und Lebenszeit-Timer:

s > u Setup > Telefon > Zurücksetzen > Alle Einstellungen

Daten löschen

Vorsicht: Mit dieser Option werden alle von Ihnen 

eingegebenen Daten gelöscht (einschließlich 
Kontakte und Kalendereinträge) sowie alle Daten, 

die in die SIM-Karte des Mobiltelefons 

heruntergeladen wurden (einschließlich Fotos und 
Sounddateien). Diese Daten können nach dem 
Löschen nicht wiederhergestellt werden.

Mit dieser Option werden die Daten auf der 
SIM-Karte nicht gelöscht:

s > u  Setup > Telefon > Zurücksetzen > Alle Daten lösch.

Funktionen
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Gesprächsdauer und 
-gebühren
Die Netzverbindungszeit ist die Zeitspanne, die 
zwischen dem Herstellen der Verbindung zum Netz 
Ihres Diensteanbieters und dem Beenden der 

Verbindung durch Drücken von O verstreicht. Dazu 

gehören auch Besetztzeichen und Klingeltöne.

Eventuell stimmt die Zeit, die Sie mit 

zurücksetzbaren Timern erfassen, nicht mit der 

Verbindungsdauer  überein, die Ihnen von dem 

Diensteanbieter berechnet wird. Wenn Sie 

Informationen zu Ihrer Abrechnung benötigen, 

wenden Sie sich an Ihren Diensteanbieter.

Daten auf der Speicherkarte löschen

Vorsicht: Mit dieser Option werden alle von Ihnen 

eingegebenen Daten gelöscht (einschließlich 
Kontakte und Kalendereinträge) sowie alle Daten, 

die auf die Speicherkarte und/oder SIM-Karte 

des Mobiltelefons heruntergeladen wurden 
(einschließlich Fotos und Sounddateien). Diese 
Daten können nach dem Löschen nicht 
wiederhergestellt werden.

s > u  Setup > Telefon > Zurücksetzen > Speicherk. lösch.

Funktionen

Funktionen

Gesprächszeit

Gesprächstimer anzeigen:

s > q Anrufliste, drücken Sie Optionen > Gesprächszeit

Gesprächsdaueranzeige

Anrufzeit während eines Anrufs anzeigen:

s > u Setup > Anrufe > Gesprächsopt. > Gesprächstimer
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Freisprecheinrichtungen
Hinweis: Die Benutzung von Mobiltelefonen kann 
beim Führen eines Kfz Ablenkungen verursachen. 
Beenden Sie das Gespräch, wenn Sie sich nicht auf 
das Fahren konzentrieren können. Außerdem ist die 
Verwendung von drahtlosen Geräten und deren 
Zubehör in bestimmten Umgebungen unter 
Umständen verboten. 
Die Gesetze und Vorschriften zur Nutzung dieser 
Produkte müssen stets eingehalten werden.

Gesprächsgebühren

Gebührenzähler und Guthabeninformationen 
anzeigen:

s > q Anrufliste, drücken Sie Optionen > Anrufkosten

Gesprächsgebühreneinrichtung

Guthaben einstellen:

s > q Anrufliste, drücken Sie Optionen > Anrufkosten 
> Gesprächsgebühreneinrichtung

Datenzeiten

Datenruf-Timer anzeigen:

s > q Anrufliste, drücken Sie Optionen > Datenzeiten

Datenmengen

Datenmengenzähler anzeigen:

s > q Anrufliste, drücken Sie Optionen > Datenmengen

Funktionen

Funktionen

Automatische Rufannahme (Headset)

Automatische Rufannahme, wenn ein 
Autoeinbausatz oder Headset angeschlossen ist:

s > u Setup > Telefon > Headset-Einst. > Auto-Antwort



82 Weitere Funktionen - Netz

Netz

Sprachwahl (Headset)

Sprachwahl mit der Sende-/Endetaste des 
Headsets aktivieren:

s > u Setup > Telefon > Headset-Einst. > Sprachwahl

Funktionen

Netzeinstellungen

Netzinformationen anzeigen und 
Netzeinstellungen anpassen:

s > u Setup > Netz

Funktionen

Software-Update

Ihr Diensteanbieter kann Software-Updates 
über das Mobilfunknetz an Ihr Telefon senden. 
Wenn Sie ein Update mit dem Telefon empfangen, 
können Sie es sofort installieren oder die Installation 
auf einen späteren Zeitpunkt verschieben. 
So installieren Sie ein Software-Update zu einem 
späteren Zeitpunkt:

s > u Setup > Telefon > OTA-Updates > Software aktualis.

Funktionen
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Tools

Funktionen

Weckfunktion einstellen

s > m Tools > Wecker

Schnellzugriff: Drücken Sie im Standby-Display 
Optionen > Alarm einstellen.

Alarm deaktivieren

Auf dem Display wird ein Alarm angezeigt: 

Um den Alarm zu deaktivieren, drücken Sie Stopp 
oder O.

Um eine Verzögerung von acht Minuten zu 
veranlassen, drücken Sie Ern. erinn.

Standardansicht des Kalenders einstellen

s > m Tools > Kalender, drücken Sie Optionen 
> Kalender-Setup > Standardansicht

Neuen Kalendertermin hinzufügen

s > m Tools > Kalender, blättern Sie zu dem Tag 
und/oder der Startzeit, drücken Sie s, und geben 
Sie die Termindetails ein.

Sie können Musik- oder Sound-Dateien, 
Sprachmemos oder Videos als Erinnerung für ein 
Kalenderereignis festlegen. Beim Erstellen eines 
Kalenderereignisses wählen Sie Alarmstil: > Signaltyp 
aus, blättern Sie zu der Datei (oder erstellen Sie eine 
neue Datei), drücken Sie Einfügen.

Kalendertermin anzeigen

s > m Tools > Kalender > Termin

Zum Bearbeiten der Termindetails drücken Sie 
Optionen > Bearbeiten.

Funktionen
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Terminerinnerung

Auf dem Display wird eine Terminerinnerung 
angezeigt und ein Signal dafür ausgegeben:

Um die Details zur Erinnerung anzuzeigen, wählen 
Sie Termin öffnen.

Um die Erinnerung zu schließen, drücken Sie Stopp.

Kalendereintrag an ein anderes Gerät senden

Kalendertermin an ein anderes Mobiltelefon, einen 
Computer oder ein anderes Gerät senden:

s > m Tools > Kalender > Termin, drücken Sie Optionen 
> Freigeben an > Bluetooth oder Nachricht

Funktionen

Heruntergeladene Dateien verwalten

Verwalten Sie Dateien und Anwendungen, die Sie 
vom Browser über eine Bluetooth®-Verbindung auf 
das Telefon heruntergeladen haben:

s > m Tools > Download-Manager

Weltuhr

Uhrzeit und Datum für mehrere Städte in der 
ganzen Welt anzeigen:

s > m Tools > Weltuhr

Aufgabenliste

Checkliste für anstehende Aufgaben erstellen und 
das Telefon für die Benachrichtigung von fälligen 
Aufgaben einrichten:

s > m Tools > Aufgabenliste

Funktionen
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Notizen

Notizen auf dem Telefon schreiben und speichern:

s > m Tools > Notizen

Sprachaufzeichnung

s > j Multimedia > Voice Recorder, drücken Sie s, 
um mit der Aufnahme zu beginnen, drücken Sie 
Stopp, um die Aufnahme zu beenden

Um die Sprachaufzeichnung zu speichern, drücken 
Sie Speichern.

Drücken Sie Optionen, um weitere Funktionen für die 
Sprachaufzeichnung auszuführen.

Hinweis: Die Aufnahme von Anrufen unterliegt den 
jeweils gültigen Gesetzen zu Datenschutz und 
Gesprächsaufzeichnung. Die Gesetze und 
Vorschriften zur Nutzung dieser Funktion müssen 
stets eingehalten werden.

Funktionen

Sprachaufzeichnung abspielen

So starten Sie die Wiedergabe einer 
Sprachaufzeichnung:

s > j Multimedia > Media Finder > Sprachmemo 
> Sprachaufzeichnung

Taschenrechner

s > m Tools > Rechner

Währungsrechner

s > m Tools > Rechner, drücken Sie Optionen 
> Wechselkurs einstellen, geben Sie den Wechselkurs ein, 
drücken Sie Einstellen, geben Sie den Betrag ein, 
drücken Sie Optionen > Währung umrechnen

Funktionen
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Sicherheit

Spaß und Spiel

Funktionen

SIM PIN

Vorsicht: Wenn Sie dreimal hintereinander einen 
falschen PIN-Code eingeben, wird die SIM-Karte 
gesperrt. Das Mobiltelefon zeigt dann die Meldung 
SIM gesperrt an.

SIM-Karte sperren oder entsperren:

s > u Setup > Sicherheit > SIM-PIN

Sperren von Anwendungen

s > u Setup > Sicherheit > Anwend.sperre

Zertifikatverwaltung

Im Telefon gespeicherte Zertifikate für den 
Internet-Zugriff aktivieren oder deaktivieren:

s > u Setup > Sicherheit > Zertifikate

Zertifikate ermöglichen es Ihnen, beim 
Herunterladen von Dateien oder bei der Freigabe 
von Informationen die Identität und Sicherheit von 
Webseiten zu prüfen.

Funktionen

Spiel oder Anwendung starten

Java™-Spiel oder -Anwendung starten:

s > T Spiele > Spiel oder Anwendung

Funktionen
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Flugzeugmodus

Schalten Sie die Anruffunktionen des Telefons an 
Orten aus, an denen Mobiltelefone verboten sind. 
Mit dieser Option können Sie den Musik-Player und 
andere Funktionen, die nicht vom Netz abhängig 
sind, verwenden, wenn Sie sich in einem Flugzeug 
befinden, ohne die Kommunikationsfunktionen des 
Flugzeugs zu stören.

s > u Setup > Telefon > Flugzeugmodus > Ein

Um die Anruffunktionen des Telefons wieder zu 
aktivieren, schalten Sie den Flugzeugmodus aus.

Funktionen
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Daten zur spezifischen Absorptionsrate

Daten zur spezifischen AbsorptionsrateDieses Telefonmodell entspricht den internationalen 
Richtlinien für die Begrenzung der Exposition durch 
elektromagnetische Felder.
Ihr Mobiltelefon ist ein Radiosender und -empfänger. Es ist so 
konzipiert, dass die international empfohlenen Höchstwerte für die 
Belastung durch elektromagnetische Felder nicht überschritten werden. 
Diese Richtlinien wurden von einer unabhängigen wissenschaftlichen 
Organisation, der ICNIRP, erarbeitet und beinhalten 
Sicherheitsfaktoren, die den Schutz aller Personen unabhängig von 
Alter und Gesundheitszustand sicherstellen.
Die Richtlinien verwenden eine Maßeinheit, die als SAR (Specific 
Absorption Rate) oder spezifische Absorptionsrate bezeichnet wird. Die 
von der ICNIRP festgelegte SAR-Höchstgrenze (ICNIRP SAR) für 
Mobilfunkgeräte beträgt für die allgemeine Bevölkerung 2 W/kg. Der 
höchste SAR-Wert, der bei Prüfungen mit diesem Gerät am Ohr 
gemessen wurde, betrug 0,86 W/kg1. Da Mobilfunkgeräte die 
verschiedensten Funktionen bereitstellen, können sie auch an anderen 
Betriebspositionen verwendet werden, beispielsweise am Körper2 
(siehe Bedienungsanleitung). In diesem Fall betrug der höchste 
gemessene SAR-Wert 0,51 W/kg1.
Da der SAR-Wert bei der maximalen Sendeleistung des 
Mobilfunkgeräts gemessen wird, liegt der tatsächliche SAR-Wert für 
dieses Gerät während des Betriebs typischerweise unter dem 
genannten Wert. Das ist darauf zurückzuführen, dass die Sendeleistung 
des Geräts automatisch auf den geringstmöglichen Wert eingestellt 
wird, der erforderlich ist, um das Netzwerk zu erreichen. 

SAR-Werte für verschiedene Telefone und Bedienpositionen können 
voneinander abweichen. Sie entsprechen jedoch alle den behördlichen 
Anforderungen für einen sicheren Betrieb. Bitte beachten Sie, dass 
technische Weiterentwicklungen an diesem Modell zu veränderten 
SAR-Werten für neuere Produkte führen können. In allen Fällen 
genügen die SAR-Werte aber den Anforderungen der Richtlinien.
Nach Einschätzung der Weltgesundheitsorganisation (WHO) sind nach 
dem gegenwärtigen Stand der Wissenschaft keine besonderen 
Vorsichtsmaßnahmen für den Betrieb von Mobilfunkgeräten 
erforderlich. Um die Belastung zu verringern, empfiehlt sie, die Dauer 
von Gesprächen zu begrenzen und/oder Freisprecheinrichtungen 
einzusetzen, um einen möglichst großen Abstand zwischen 
Mobilfunkgerät und Kopf bzw. Körper einzuhalten.
Weitere Informationen hierzu finden Sie auf den Websites der 
Weltgesundheitsorganisation 
(http://www.who.int/emf) und von Motorola, Inc. 
(http://www.motorola.com/rfhealth).
1. Die Tests wurden in Übereinstimmung mit internationalen 

Prüfrichtlinien durchgeführt. Der Höchstwert enthält einen erheblichen 
Sicherheitsfaktor als zusätzlichen Schutz für die Bevölkerung und zur 
Berücksichtigung von möglichen Messabweichungen. Weitere 
Informationen hierzu finden Sie im Motorola Testprotokoll sowie den 
Unterlagen zum Beurteilungsverfahren und zur Messfehlergenauigkeit 
für dieses Produkt.

2. Bitte beachten Sie für den körpernahen Betrieb den Abschnitt 
Sicherheitsrelevante und allgemeine Informationen.
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INFORMATIONEN ZU OPEN SOURCE SOFTWARE

INFORMATIONEN ZU OPEN SOURCE SOFTWAREUm Informationen zu erhalten, wie Sie eine Kopie der von 
Motorola öffentlich zur Verfügung gestellten Quellcodes erhalten 
können, die in der Software dieses Mobiltelefons von Motorola 
verwendet werden, senden Sie eine schriftliche Anfrage an:

Die Website opensource.motorola.com von Motorola enthält 
ebenfalls Informationen über die Verwendung von Open Source 
durch Motorola.
Die von Motorola erstellte Website opensource.motorola.com 
soll als Portal zur Interaktion mit der Software-Community dienen
Um weitere Informationen zu Lizenzen, Bestätigungen und 
erforderlichen Urheberrechtshinweisen für Open Source-Pakete zu 
erhalten, die in diesem Mobiltelefon von Motorola enthalten sind, 
führen Sie die nachstehenden Schritte aus:
1 Wählen Sie im Hauptmenü die Option „Setup“.

2 Wählen Sie unter „Setup“ die Option „Telefon“.

3 Wählen Sie unter „Telefon“ die Option „Rechtliche 

Hinweise“.

MOTOROLA, INC.
OSS Management
600 North US Hwy 45
Libertyville, IL 60048
USA
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Digitales Audio  40
Display  4, 14, 31
Download-Manager  84
Drucken  63, 66
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E

Easy SMS  56
EDGE-Anzeige  15
Eingegangene Anrufe  33
Eingehender Anruf (Meldung)  34
Einstellungen zurücksetzen  79
E-Mail

Lesen  56, 57
Ordner erstellen  57

E-Mail-Adresse  74
E-Mails

Einrichten  56
Senden  56

Entsperrcode  23, 24
Entsperrcode eingeben (Meldung)  

23
Entsperren

SIM-Karte  86
Telefon  23, 24

Entwurfsordner  54
Erinnerungen  79

F

Feste Nummern  73
Flugzeugmodus  87
Foto  37
Freisprechfunktion  22

G

Gebührenzähler  81
Gesprächsanzeige  16
Gesprächstimer  80, 81
Gewählte Rufnummern  33
GPRS-Anzeige  15

H

Halten eines Anrufs  71
Headset  81
Headset-Anschluss  48
Helligkeit  31
Hörmuschellautstärke  20

K

Kabel verwenden  61
Kalender

Ansicht festlegen  83
Synchronisieren  59
Termin hinzufügen  83
Termin senden  84

Kamera  37
Kamerataste  2
Klingelton  25
Klingelton-ID  35, 76
Klingeltonlautstärke, anpassen  25
Konferenzgespräch  72
Kontakte filtern  76
Kontaktliste

Anzeigen  76
Bild-ID  34
Eintrag hinzufügen  74
Filter  76
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Kontakt senden  78
Synchronisieren  59

Koppeln. Siehe Bluetooth

L

Lautsprecher  81
Lautstärke  20, 25
Lautstärketasten  2, 20
Leitung 1 und Leitung 2  16
Löschtaste  2

M

Mailing-Liste  76
Medienlautstärke, anpassen  25
Medienobjekte herunterladen  57
Medienwiedergabe  25
Menü  4, 14
Menüsymbole  14
MFV-Töne  74
Micro-USB-Anschluss  2, 13, 61
Mittlere Taste  12, 14

MMS-Nachricht  53
MMS-Nachrichtenvorlage  56
MOTOSYNC  59
MP3-Audiodateien  40
Musik-Player  40

N

Nachricht
Lesen  54, 56
Senden  53

Nachrichtenerinnerungen  79
Nachrichtensymbol  15, 54
Navigationstaste  12
Netzeinstellungen  82
Neu  26
Neuer Anruf  72
Niedriger Akkustand (Meldung) 16
Notizen 85
Notrufnummer  35
Numerischer Modus  20

O

Optionale Funktion  12
Optionales Zubehör  13
Öse für Tragriemen 2

P

Passwörter. Siehe Codes
Personalisieren  79
PIN2-Code  23, 73
PIN-Code  23, 86
Profil  26
Profilanzeige  15
Profile  15, 25
Prüftaste  2

R

Rechner  85
Rechter Softkey  2
Rück-/Löschtaste  2, 18
Rufumleitung  72
Rufumleitung (Symbol)  16
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S

Schnellwahl  71
Screensaver  28, 32
Sicherheitscode  23
Signal

Abschalten  20, 33
Festlegen  25, 28

Signalprofil  21, 25
Signalstärkeanzeige  15
Signalton  28, 44
Signaltyp-Profile  15
SIM gesperrt (Meldung)  86
SIM-Karte  23, 73, 86
SIM-Karte, Daten löschen  80
Softkeys  14
Software-Update  70, 82
Speicherkarte  60
Sperren

SIM-Karte  86
Telefon  24

Sperren/Entsperren-Taste  21

Sprachaufzeichnung  85
Sprachbefehle  21
Sprache  79
Sprachnachrichten  36
Sprachnachricht-Symbol  36
Sprachwahl  21, 82
Standby-Display  4, 14
Stereokopfhörer  47
Stumm, Profil  25
Stummschalten eines Anrufs  71
Suchen  69
Symbol-Eingabemodus  20
Synchronisieren  59

T

Tastatur sperren und entsperren  2
Tastaturlautstärke, anpassen  25
Taste für einfaches Senden  2
Telefonnummer

Ihre Nummer  73

Speichern  74

Telefonnummer wählen  73
Telefonnummern speichern  74
Text bearbeiten  18
Text löschen  18
Texteingabe  17
Texteingabemodus  19
Textnachricht  53
Textnachrichten  53
Textvorlagen  56
Theme  28
Timer  80, 81
TV Out  69
TV Out ein  70

U

Uhr  27
UKW-Radio  48
USB-Kabel  61
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V

Verbinden. Siehe Bluetooth
Vereinfachte Worteingabe  18
Verpasste Anrufe (Meldung)  34
Vibrationsprofil  25
Video  37
Vorschau-/Umschalttaste 2

W

Wahlwiederholung  34
Wallpaper  28
Webseiten  51
Wecker  83
Weiterleiten eines Anrufs  72
Weltuhr  84
Wiedergabelautstärke  21
WiFi  68
WiFi ein  69
WiFi-Anzeige  15
WiFi-Optionen  69

WLAN  69

Wort, Eingabemodus  18

Z

Zeit  27
Zertifikatverwaltung  86
Zoom-Tasten  2
Zubehör  13, 47, 63, 81
Zurückrufen  34
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